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Chapter 1: Introduction

The Clampfit Batch Analysis Software provides several sample macros with corresponding
sample data that you can import.

Configuring MDC File Server

You can change the storage location if it becomes full, and the database keeps track of data
files in multiple storage locations. If you set a new storage location, keep the existing data
storage location. Before you start the Clampfit Software to run Batch Analysis the first time, you
must configure MDC File Server. MDC File Server is required to manage imported data. The
MDC File Server must be running for Clampfit Software Batch Analysis to run.

To configure MDC File Server:

1. After you install the pCLAMP software,open the MDC File Server Manager from Start > All
Programs > Molecular Devices > MDC File Server > MDC File Server, right-click and select
Run As Administrator.

2. In the MDC File Server Manager dialog, click Select File Directory.

Note: If you select a computer other than the local one, the software must have
access permissions to the folder location at all times.

3. Click Create New Folder.
4. In the Name field enter the name of the file server and then click OK.
5. In the Select Port field, enter 9200 and then click Apply.
6. Click Start and wait for the Start button to become unavailable.
7. When the Start button is inactive, click Close.

1
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First Time Use Database Configuration

If this is the first time you use the Clampfit Software Batch Analysis, do the following to
configure the data storage folder:

1. Ensure that the Clampfit Software license key dongle is installed on the computer that the
software is installed.

2. Start the Clampfit Software.
3. Select Batch Analysis > Run.
4. When the Storage Location message displays, click OK.

5. When the Storage Location Type dialog displays, click to display the Create New File
Storage dialog.

6. To create a new file storage location:
a. In the Display Name field, enter the name of the data file storage folder.
b. In the Server Name field, verify that the local computer name is correct.
c. In the Port field, leave the default setting as 9200.
d. Click OK to display the Storage Location Type dialog.

7. Confirm that Yes displays under the Available heading.
8. Click Refresh to update the list.
9. Click OK.
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Importing Data Files

The Clampfit Advanced Analysis software installer includes sample macros to familiarize
yourself with the Batch Analysis functionality. To use these sample macros, you must import the
sample data files. When you import your own data files they must be .abf files from the Clampex
Software.

The following procedure uses the imported sample data Peak Data to use with the installed
sample macro DemoPeak. These procedures apply to any imported sample data to use with
any of the other corresponding sample macros.

To import data files:

1. In the Batch Analysis dialog, select File > Import Data > Entire Folder.
2. Navigate to C:\Program Files\Molecular Devices\pCLAMP 11\Sample Macros\Peak Data.
3. Click Open.

Tip: Windows 10 users, if clicking Open fails, double-click on Peak Data.

4. On the confirmation message, click OK.
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Running Sample Macros

The following procedure uses the imported sample data Peak Data with the installed sample
macro DemoPeak. See Importing Data Files on page 9.
These same procedures apply to any other imported sample data used with any of the other
corresponding sample macros.

To run a sample macro:

1. In the top left quadrant of the Batch Analysis window under Data Selector, double-click the
data folder you imported to load the Trials.

2. In the bottom left, select the Analysis tab.
3. In the Macros panel, in the Sample tree, right-click DemoPeak and select Run Macro.

When a macro runs successfully, the lower right panel displays the measurements table
and associated graph.
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Creating Macros

Any number of commands from the Analysis menu can be tied together as a single analysis
sequence and stored in a macro. These new macros get stored in the Macros pane on the
Analysis tab.

To create a macro:

1. In the Batch Analysis dialog, select Macros > Record to display the Record Macro dialog.
2. In the Name field, enter the macro name. Do not press Enter.

3. Click the Analysis menu to select options and specify settings. The steps display in the
Record Macro dialog as they are added.

4. When you finish adding steps, in the Record Macro dialog, click Stop to save the macro and
it displays in the Macros pane on the Analysis tab under User.

Tip: You can edit macros in the User tree.



Clampfit Batch Analysis User Guide

12 5061586 E

Modifying Sample Macros

Macros in the Sample tree are read-only. To view macro step settings, in the Macros pane on
the Analysis tab, expand the macro name and double-click on a step.

To edit macros, right-click the sample macro name and select Make a User Copy. It is copied to
the User macro tree, where you open the Analysis steps within the macro to reconfigure them.
Click OK to save changes.

You can rename the macros and change the comments from the right-click menu.

You cannot add or remove steps to a macro when you edit it. To do this, record a new macro
and use Run Step to copy the steps from the existing macro into the new one. Skip steps that
are not wanted, or add new steps from the dialogs in the Analysis menu.

To delete a macro from the User tree, select the name and press Delete.
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Chapter 2: From Import to Analysis

This chapter provides details of Clampfit Batch Analysis features and usage, following typical
data flow from data importation, querying and preparation for analysis, through analysis and
results handling.

Import Data Files

The files you import into Batch Analysis are Clampex Software .abf data files. When you select
to import data files, you can import up to 100 individual files or an entire folder of files.

To import data files:

1. In the Batch Analysis dialog, select File > Import Data Files > (Individual Files or Entire
Folder).

2. Navigate to the .abf files.
3. Click Open, or Select depending on the operating system.

Tip: If clicking Open fails, double‐click on the folder.

4. In the confirmation message, click OK.

2
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Interface Overview

The following sections describe the various parts of the software interface.

Main Menus

The main menu bar in Clampfit Batch Analysis includes various menus when a dataset window
is open. Most of the options in the menus are also available as keyboard shortcuts, buttons, or
are in popup menus.

The following are short descriptions of each menu.

File: This menu has file import and export options, file information, and printing setup. The
first set of commands run database queries for the current selection in the Data Selector.
Edit: The most important commands are Undo and Redo which undo and reapply edit and
analysis commands. Select Copy to copy results data, graphs, and lists to the computer
clipboard.
View: This menu has options to set the way datasets appear. Open the Attributes dialog
from this menu. Open the Layout window from this menu.
Dataset: All commands to alter the content of datasets and save datasets are in this menu.
It includes the Analyze commands that determine which items in the dataset will have
analysis applied to them.
Trial Editing: The commands in this menu all change data recorded in trials, creating
modified trials as output. Some commands (left‐hand list) apply to all the trials in the dataset
selected for analysis, at once. These commands can be included in macros. The right‐hand
commands only ever apply to one trial at a time, and cannot be included in macros.
Analysis: All commands that generate results sheet output, or graphs, are in this menu.
Some commands apply to trials and others take results sheet columns as input. All these
commands can be included in macros.
Macros: All commands for recording, running, and managing macros are in this menu.
Configure: The Program Options dialog has program settings and options to configure
dataset lists and tree hierarchies.
Database: General database options to create new databases, select a database, and
configure file storage locations.
Window: Standard Windows window management, select dataset windows here if you have
multiple datasets at once.
Help: Access the manual in .pdf, web links, including software updates, and the About
dialog.



Chapter 2: From Import to Analysis

5061586 E 15

Data Tab

The Data tab provides access to data in the database. There are two panes, Data Selector and
Datasets.

Data Selector

The Data Selector pane is a hierarchy of database attributes you use to create queries to return
data from the database, into temporary datasets. Double‐click nodes to retrieve data from the
database.

Most database attributes can be included in the hierarchy, in any order (Configure > Data
Selector Hierarchy, or Data Selector popup menu). See Create Datasets on page 19.

Datasets

The Datasets pane displays saved datasets under a short hierarchy. Data returned from a query
with the Data Selector is tidied, removing bad files and preprocessing some trials (for example,
removing traces) to make the data ready for analysis. Then it can be saved in a dataset. Analysis
results are always saved with the dataset they were derived from. See Saving Datasets on page
24.

Analysis Tab

There are two panes. Command History records the analysis commands run on the current
dataset and Macros.

Command History

In the Command History, each new trial editing or analysis command for the dataset is listed.
Macros are added as single nodes that open to show the constituent steps.

Open steps with a double‐click or click Properties to display the dialog for the analysis (read
only) populated with the settings.

Click View Analysis Set or select Command History from the popup menu to display a dialog
that reports the trials or data on the Dataset Results tab, that the selected analysis step was
carried out on. The destinations of the analysis (Trials or Dataset Results) are also reported.

Select Show Cursor Positions from the popup menu to shift the cursors in the open trial to the
boundaries of the search and baseline regions used in the analysis step. This command only
applies to analysis steps that used search regions, and within this, to analyses where the
regions were defined as cursor regions (in contrast to using epochs to define the regions).

If you undo an analysis step, the node is removed from the bottom of the Command History.

Macros

The Macros pane has buttons for common macro commands, and lists macros in three folders.
See Macros on page 29.
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Dataset Windows

Clampfit Batch Analysis can have multiple datasets open at once, each in a separate dataset
window. If you run a new query from the Data Selector pane with File > Open, or by double‐
clicking a Data Selector node, the new dataset replaces the existing one in the dataset window
that last had focus. Alternatively, you can create a new dataset in a new window with File >
Open in New Window.

You can add data to a dataset at any stage by selecting a node in the Data Selector pane and
using File > Add Tree Selection to Current Dataset.

Dataset windows can be minimized, tiled, and arranged within the central area of the interface.

Each new dataset window is numbered in the top‐left corner of the title bar. The name of saved
datasets is reported at the top of the window, or Temporary displays for temporary datasets.
The Window menu has a list of open dataset windows that you can use, bringing it to the front.

The number of trials in each dataset is reported in the dataset Status Bar at the bottom of the
dataset window. If a trial edit or analysis steps has been run on a dataset, they display in the
Command History pane when you select the dataset.

Each dataset window has three tabs:

Trials: Lists all the trials in the dataset in the top half, and has a graphical display of one trial
at a time in the bottom half. Columns in the trials list are configurable to show database
attributes for the trials.
There are a number of display options, open popup menus from the main data area, axis
areas or cursors for these. The Properties dialog opens from the main‐area popup menu
with many additional configuration options.
Set axis scaling and other options to apply when you open trials into the trace display with
the Configure menu Program Options > Open Trial Options, for example, to always show
the entire X‐axis range when you open new trials, or to retain the current X‐axis range so
you can zoom in to a particular region, then scroll through all the trials looking at just that
region with the Open Trial Options.
Analysis Results: Results of analyses applied to the trials are written to a spreadsheet in the
left half of the pane. Graphs of the spreadsheet data display in the right half of the pane.
Dataset Results: This tab has one sheet for results from across all the trials in the dataset.
The sheet has the same format as the analysis results, half spreadsheet and half graph.

Program Options

The Configure > Program Options dialog has display and program behavior options that affect
the interaction with the Clampfit Batch Analysis program. You can return all or selected settings
to their defaults with buttons at the bottom of the dialog.

Open Trial Options

The settings in this section define how to open new trials into the Trials tab.

For example, the X Axis Scaling of each new trial can open as either:

Full Scale
Keep Existing, if, for example you zoomed in to view a particular region and want to see this
same region in new trials.
Use Acquisition, with the same X‐axis range used during acquisition.

There are options for Y Axis Scaling, Sweep Selection, and Signal Selection.
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Display Options

This section has a number of options that affect how information displays in Clampfit Batch
Analysis, as well as settings that allow you to change the look and feel of the program, for
example, title bar colors.

Beyond the coloration options, there are settings for:

Time Precision: Set the number of decimal places to use in the display of time values
throughout the program, from zero to three. This option is for display purposes only.
Analysis uses the full time information.
Data Selector Chronological Ordering: Set so that time and date attributes in the Data
Selector have the most recent nodes at the top or the bottom.
Data Selector Sub‐Item Display: Nodes in the Data Selector can show the number of nodes
at the level below. This field sets a threshold such that if there are more nodes at the level
below than the number you enter, the number of these displays, but otherwise not.
Data Selector Empty Items: Normally this setting should stay at Hidden. When the Visible
option is shown, nodes with value <none> display. These nodes should have no trials under
them, but with faulty importation it is possible to get trials here. Use this option for trouble‐
shooting to find missing data.
User-Defined Columns: If you have user‐defined columns (for example, columns that show
more than one attribute) in the trials name, these columns display here. See User-Defined
Columns on page 21.

Graph Options

This section has options that control the creation of graphs and the linkage between graphs
and the spreadsheet data they plot.

Synchronize Selected X/Y Columns: When available, click on a point in a graph plot to
select the X and Y columns for the plot, on the spreadsheet. Within the selected columns,
the X and Y coordinates of the individual point are further highlighted.
Plot Selection Distance: The number of pixels from a graph point within which you must
click to select the point.
Selected Graph Point Cursor: When available, the selected point in a graph displays with
dashed cross hairs. When not used, the cross hairs are removed.
Automatic Graphing: When available, the software automatically generates a graph when
you run an analysis, selecting the X and Y parameters from the analysis output. If Skip
Dialog is available, the graphs generate without opening the Graph dialog for configuration.
With Merge Graphs on, output from new analysis steps are plotted on an existing graph, if
possible. Otherwise each analysis creates a new graph.

General Options

This section has downloading options:

Maximum Cache Size: Sets the size of the cache folder (in MB) on the computer:
C:\Users\[UserName]\AppData\Local\Temp\BatchAnalysis Cache
where data files are stored when they are downloaded from the database. Once the cache
is full, the least recently used files are removed to allow the download of new files.
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Layout Window

Use the Layout window for simple layout functionality to generate printed reports, for example,
for printed laboratory records. It is not intended for publication‐quality layouts.

Open the Layout window from the View menu or the toolbar button. Keep the window open
while you use Clampfit Batch Analysis to move to different locations in the client and copy data
to the window. You can copy data and graphs to the window, write text, and create simple
drawings.

Layouts are saved as .alf files.

All pages printed from the Layout window have a footer with the date and time of printing and
the user name. Page headers are user‐configurable.

Copy and Print

Many elements of the Clampfit Batch Analysis client interface can be copied onto the computer
clipboard for pasting into other applications, or printed directly from the window where they are
contained.

Data from the results spreadsheets, graphs, lists and trials can be copied to the Layout window
and printed from there.

Printing and copying apply to the window and sheet in view, for example, if you have results
graphs for multiple trials you can only copy one graph at a time. Use File > Export Results to get
data for all graphs in one step.

If you copy a graph from the Results window you may need to use Paste Special in the
application you copy it into in order to have the graph, rather than its raw data, appear.

All printouts have the date and time of printing on every page. Additional header and footer
information can be included for printouts from the Layout window.

You can preview pages to print in the File > Print Preview dialog.

The printable items are:

Trials Lists: These lists print showing the columns configured in the interface, using the
same column widths. It is good to use View > Column Widths > Auto Fit All before you print
to ensure all data is in view.
Trials: As configured in the View > Command History > Properties dialog for display on the
Trials tab, and then in the File > Page Setup dialog to select which elements to print.
Results Sheets: Prints the graph or spreadsheet, whichever has focus. The spreadsheet is
printed as what you see is what you get (WYSIWYG), so ensure the columns are widened to
show all data before you print.
Layout Window: This dialog has Page Setup and Print commands. You configure the
headers and footers for the printout.
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Create Datasets

After you import files into Clampfit Batch Analysis, use the Data Selector to query the database.

The Data Selector is a user‐configurable tree‐hierarchy of database attributes. To configure the
hierarchy use Configure > Data Selector Hierarchy > attributes, or open the dialog from the
Data Selector popup menu. See Attributes on page 19.

You can set:

The attributes used in the tree (any number).
The order of the attributes.

For example, the default configuration orders the tree by protocol, trial date, trial name, and trial
time, but you can elevate the trial date to the top of the hierarchy if this is more convenient, or
select other trial attributes to include.

Double‐click on a node in the Data Selector to send a query to the database to return all data
files with the selected node’s attribute as well as attributes at higher levels on the same branch
of the tree.

The File > Add Tree Selection to Current Dataset command (also in the popup menu) allows
you to add data from new, different nodes in the Data Selector to the current dataset.

The result of a database query is the creation of a temporary dataset, of all matching data files,
in a dataset window.

By using the Data Selector option Open in New Window, you can create numbers of distinct
datasets in separate windows at the same time.

Datasets consist of Trials, which are .abf raw data recordings.

Attributes

Attributes are the properties used by the Clampfit Batch Analysis database to store and identify
data files. Most attributes can be used to query the database from the Data Selector, and
theseattributes are available for display in columns in the trials lists.

All attributes for a trial can be viewed in the View > Attributes dialog (or use the toolbutton in the
top‐right corner of the dataset window) when the item is selected in its list.

To output attribute values in results, or use them in analysis, write them to the results sheets
with Analysis > Get Attributes.

Attributes are categorized in the dialogs where they can be browsed, to make it easier to locate
them. The attributes are included in the All Categories grouping, and a subset of these display
in the Frequently Used group. They all display in one of the remaining categories. Trial‐level
attributes are divided between two categories: Trial Data and Trial Other.
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Trial Data

The Trial Data class has attributes directly related to the data recorded in a trial.

Acq. Sweeps: Reports the number of sweeps in the trial. Acq. is short for acquisition, which is
important because this value does not change if a trial is edited and sweeps removed or added.

Acquisition Mode: Refers to the protocol that generated the trial. Possible values are:

Gap‐Free
Variable‐Length Events
Fixed‐Length Events
High‐Speed Oscilloscope
Episodic Stimulation

Clampex Software uses the last two modes, referred to as Compound Triggered (for High‐
Speed Oscilloscope), and Internally Triggered (for Episodic Stimulation) in the Edit Protocol
dialog.

Amplifier Mode: The clamping mode, voltage clamp, or current clamp, under which the data
were acquired.

Trial: Ra, Trial: Rm and Trial: Cm: Clampex Software‐only attributes that report the last single
recorded value of access resistance, membrane resistance, and membrane capacitance prior to
the trial.

Cm Compensation: Reports the membrane capacitance compensated for in amplifier settings
when the trial was recorded.

Analog Bandwidth: Reports the net lowpass cutoff frequency at which the trial was filtered.

Hardware Filter: The lowpass cutoff frequency set on the amplifier, prior to any additional
software filtering.

Stopwatch: The time in seconds from the start of the experiment.

Trial: ID: The number of the trial.

Trial Other

This category has trial‐level attributes not immediately relevant to the trial data. Many of the
attributes are inherited from the pCLAMP Data File Index (DFI) and report whether certain
protocol options were used or not. For example, Digital Output and External Tags are in this
category.

Trial: Time: The clock time that the trial began recording.

Trial: Name: The trial file name.

Browse Datasets

After you create a dataset by running a query on the database, you can view trials and access
information about the data contained in the dataset.

When you select a trial in the list, it automatically opens in the lower section on the Trials tab. If
you select multiple trials, the top‐most of the trials in the list opens (unless a different one of the
selected trials was already open).

Since selections on a tab can change while the tab is out of view by changing the selection on
the tab in view, the trial or results on view can change while a tab is out of view.
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Viewing Trials

In the default settings, when a dataset is created, the first trial automatically appears. After a trial
opens on the Trials tab, you can view trial header information from File > File Properties (or use
the tab button).

You can open one or more trials into Clampfit Software (Analysis > View in Clampfit). Trials
cannot be returned to the database from Clampfit Software.

Viewing Attributes

All attributes are available for inclusion as columns in the trials, lists (Configure > Select
Columns, or popup menu).

After you configure the list columns attributes you can order the lists on one attribute by clicking
its column title. Click again to reverse the order.

You can order on more than one column, to order one attribute within a higher‐level ordering of
another. When a list is refreshed, ordering is persisted on a maximum of two columns, so if rows
were ordered on three columns, it is possible to lose the ordering at the lowest level.

All the attributes for individual selected trials can be viewed in View > Attributes, or use the
toolbar button in the top‐right of the dataset window.

Lists can be copied and printed.

User-Defined Columns

The dataset lists allow a group of attributes to be reported in a single column, in order to help
save space in the lists. One user-defined column can be created for each list. For example,
rather than showing the two attributes Trial: ID and Acq. Sweeps in separate columns you can
report both values in one column, separated by a comma. You can also name the column.

To configure a user‐defined column:

1. Go to the list to configure on the Trials tab.
2. Open the Configure > Select Columns dialog.
3. Select the Available Attributes to appear and move them to the Contents of <user‐

defined> Column.
4. In the Select Attributes From Category field, select All Categories.
5. Select <user‐defined> from the left‐hand field, and shift into the top right‐hand field.
6. Position the <user‐defined> column where you want it to appear with the up and down

arrows.
7. Click OK to display the new column in the list with title <user‐defined>.

Sorting Data

A number of attributes can display in columns in the trial lists to help keep track of where and
when Clampex Software data were generated.
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Refining and Saving Datasets

Following the creation of a dataset from a query, you can check the data before analyzing it to
remove poor recordings and tidy up recordings with spikes or anomalous traces.

There are two ways to remove items from a dataset:

Use Dataset > Remove Selected Trials from Dataset, or use the <Control + Delete> keys or
the list popup menu command.
With the Analyze parameter, you can go through the entire dataset to mark the items to
remove, then remove them in one step.

As an alternative to removing items from a dataset, you can select a subset of the trials and
create a new dataset with the Dataset > Create Dataset from Selected Items in New Window
command.

Using Analyze Buttons to Review Datasets

A way to review a dataset is to use the arrow and Analyze buttons at the top left on the Trials
tab.

1. Use the arrows to scroll through the trials.
2. To exclude a trial, click Analyze – Exclude Selected.

The trial displays No in the Analyze column.
3. Continue to scroll through the trials and click Analyze – Exclude Selected for the trials to

remove from the dataset.

After you look at the trials, click Remove Analyze “No” Items From Dataset to remove the No
trials from the dataset.

Trial Editing

Use the commands Trials in the Trial Editing menu to modify the commands. See Trial Editing
Menu on page 33.

Most the trial‐editing commands apply to all the trials in the dataset you mark for analysis, for
example, that have value Yes in the Analyze list column. When you open a dataset all trials are
marked for analysis. You can change this with the Analyze buttons in the left‐hand side of the
dataset window title bar, adding or removing trials from the following trial‐editing commands.

When you open the Trial Editing menu, the commands that apply to all of the Analyze Yes trials
are listed in the left of the menu, marked Selected for Analysis.

In contrast, two commands on the right of the Trial Editing menu are marked Selected Trial
Only. The manual baseline adjustment and trace removal commands require user input specific
to individual trials and are applied only to the trial currently open on the Trials tab.

As well as applying just to the open trial, the two Selected Trial Only commands cannot be
included in macros. If you record a macro when you use one of these commands, the command
is applied as usual to modify the trial and recorded in the Command History, but the step is
excluded from the macro recording.
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Trial Versions: Unsaved (with Asterisk) and Saved

After you modify a trial, the dataset window refreshes to display the modified version in the
trace display. Although the modification is applied and the result can be viewed, the
modifications are not yet saved. This status is indicated with an asterisk in the Analyze column.

Trials with unsaved changes can be used in further analysis steps. For example, after filtering a
trial, you can take measurements from it from the filtered data, even though the filtered version
is not yet saved. This allows you to explore the consequences of different trial modifications
without having commit to them.

If you generate results from unsaved modified trials and you want to save the results, you must
save the trial modifications first, results are always saved with the data from which they were
generated.

When you finish with the trial modifications, you can save them before running further analysis.
Save trial modifications with Dataset > Save Modified Trials, or use the toolbutton in the top
right group in the dataset window.

Save Modified Trials applies to all modified trials in the dataset, saving all these in one
operation. You can enter a comment to be recorded with the new trial versions, or select from
previous comments you have used. To comment on each modified trial individually, you must
save each trial after modifying it before modifying another.

When you save a new trial version, the comment you record is written into the file header of the
trial. This is viewed from the Revision History dialog, opened from the File menu or trials list
popup menu.

When a new trial version is saved, the original version remains unchanged in the database. The
revised version now becomes the version available for new queries on the database. It is
possible to revert to the original version. If you create further versions, copies of each version
are always retained, and reversion to any earlier version is always possible.

Revision History

Management of trial versions is all done in the Revision History dialog, File menu, or Trials list
popup menu. You can view all versions of a trial, and open them into Clampfit Software. Click
Make Current to return to an earlier version of a trial, making it the version returned from new
queries.

When you use Make Current to revert to an earlier version of a trial, the reversion creates a new
version that is a copy of the reverted to trial.

The number of versions of a trial and the number of the current version can display in trial list
columns like any other attribute, called Version Total and Version Number respectively.

When a new version of a file is saved, it inherits the attributes of the original. In most cases
these remain correct, but if sweeps are removed, this is not reflected in the Acq. Sweeps
attribute value, which continues to report the original number of sweeps.

If a dataset is saved with a particular version of a trial and that trial is later replaced by a newer
version, the version in the saved dataset does not change.
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Saving Datasets

When you are happy with the contents of a dataset, use Dataset > Save Dataset, or use the tool
button in the right of the main dataset window title bar to save it.

Saved datasets display in the Datasets section on the Data tab, below the Data Selector. The
datasets are placed into a configurable hierarchy with only two possible levels above the
datasets:

Project
Creation Date (creation date of the dataset, not when the data contained in the dataset
were generated)

At least one of these must be selected for the hierarchy.

Saved analysis results are always generated for a particular (saved) dataset, hence result set
nodes appear beneath the dataset they belong to on the Datasets tree.

After you save a dataset, it cannot be deleted or altered.

Analysis

Analysis is carried out on the trials in a dataset, and on results of previous analysis steps on the
Analysis Results and Dataset Results tabs, using dialogs in the Analysis menu. Sequences of
analysis steps can be tied together in macros. If you use a procedure to generate data in the
acquisition system it is possible to create a macro to perform the complete analysis on the data
generated by that procedure.

Analysis begins with data traces in trials on the Trials tab. These might be raw traces, or
modified (saved or unsaved) trial versions. See Trial Editing on page 22. Results from analyses
carried out on trials are written to the Analysis Results sheets. Further analysis steps can take
these results as input, writing results back to the same sheets that the input came from.

At some point of the analysis you can bring together data from the different analysis results in
the dataset, for example to average the responses from replicates.

Use either of the following options:

Copy to Dataset Results: Copies selected columns from each analysis results sheet to the
Dataset Results sheet concatenated into one column on the Dataset Results tab.
Copy to Dataset Results (group by trial): Copies selected columns from each analysis
results sheet to the Dataset Results sheet broken out into separate columns by trial on the
Dataset Results tab.

You can average the values or apply other analyses to the combined data.

Any number of graphs can be created to plot results data columns.

The following sections describe how analysis is applied in Clampfit Batch Analysis in more
detail. See Analysis Menu on page 36.
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Analyze All / Some

By default, all trials in a dataset are acted on when a trial-directed analysis is performed, for
example, when peak currents are recorded with the Measurements dialog. This is indicated by
the Yes in the left-most Analyze column in the trials list. You can select the trials to which to
apply the analysis by using the Analyze buttons to the right of the arrow buttons in the dataset
window title bar.

After results data is written to the spreadsheets, further analysis steps take the output columns
as their input. As for analysis performed on trials, analysis steps that take spreadsheet data as
input can be applied selectively, using the Analyze buttons on the Analysis Results tab.

For example, you can apply Measurements to all trials in the dataset and plot peaks over time.
You could then review the graphs and mark the cells with poor results with Analyze value No,
with the Analyze – Excluded Selected button. These trials, and their results, remain in the
dataset, but further analysis steps do not apply to them.

Results Sheets

The output of analysis applied to trials is written to the Analysis Results tab results sheets. There
is one results sheet per trial, each sheet consisting of a spreadsheet and a graph section.
Multiple graphs can be configured for each sheet. You can scroll through analysis results sheets
by clicking on the trials in the list at the top of the tab, or use the arrow buttons there.

The Datasets Results tab, where selected results from the analysis results sheets can be
brought together for averaging or other analysis across cells, has a single results sheet with the
same features as the analysis results sheets.

Use either of the following options:

Copy to Dataset Results: Copies selected columns from each analysis results sheet to the
Dataset Results sheet concatenated into one column on the Dataset Results tab.
Copy to Dataset Results (group by trial): Copies selected columns from each analysis
results sheet to the Dataset Results sheet broken out into separate columns by trial on the
Dataset Results tab.

In the Measurements dialog you can place results from multiple trials in new columns, or to add
the results from the later trials beneath the earlier ones using the same columns. All other
analysis types that apply to trials, for example, Current/Voltage, output new columns for each
trial.

Results of each new analysis are written in the next free columns to the right of existing
columns. In no case does analysis change values in place. Output columns are written to the
same sheet as their input, with the exception of the Copy to Dataset Results command, which
transfers selected columns from the Analysis Results to the Dataset Results tab.

The results spreadsheets allow no direct editing; for example you cannot delete data or enter
new values. The only way to change the contents of the results sheets is to apply analyses from
the Analysis menu.

Results columns have two title cells at the top. The top title spans the output columns from the
analysis that generated the results. It numbers the analysis step within the dataset, using the
same numbering as appears in the Command History, and names the analysis type, for
example, Measurements, Curve Fit Columns, after the analysis dialog names. The title in the
second row names the output in the particular column.

In the case of Arithmetic analysis, you can name the output column, but in every other case
column names are preset and cannot be changed.
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In many cases the source of the results in a column are identified in the second column header,
with a sequence like ‘T1S1R2’. These use the following abbreviations:

Abbreviation Meaning

T Trial: The Trial: Number attribute that identifies the trial in the analysis results.

S Signal: The signal within the trial that the result was generated from. Signals are

numbered top-down within a trial, as viewed on the Trials tab.

N.B. Signals in Clampfit Batch Analysis are numbered from 1, whereas in Clampfit they

are numbered from 0, so S0 in Clampfit is S1 in Clampfit Batch Analysis.

R Search Region: The time region within a trial that the value was generated from. Most

analyses allow only one search region, but the Measurements dialog can have up to

eight.

t Trace: Where values are generated per sweep within a trial (for example, Histogram)

each sweep, or trace, is identified with this number.

To locate the output of a step within an analysis sequence, click on the node for the step in the
Command History. This brings the appropriate tab to the front, with the output columns (or
graph) in view.

For most analyses you can click Write Data Source Information to write two additional columns
with identifying information for the input to the analysis.

If the output of an analysis contains numbers of columns with only one value, the columns are
transposed and display as two columns of parameter and value pairs. This saves space on the
spreadsheet, but each parameter is still available as a separate column for input into further
analysis steps.

Analysis Output: File Export

Spreadsheet results data can be exported as either comma-separated variable (.csv) files, or
Microsoft Excel (.xls) files. The Export Results dialog is in both the File and Analysis menus.

Export Results is included in the Analysis menu because file export can be configured as a step
in a macro, so that your results are automatically output as files when the analysis completes.

You can choose to export results from both the Analysis Results and Dataset Results tabs. If you
select to export in .csv format, one file is written for each results sheet, for example, one file for
the Dataset Results tab and as many files as there are trials for the Analysis Results tab.

If you select .xls, a single file with one sheet is generated for the Dataset Results tab, and a
single file with one sheet per trials for the Analysis Results tab results.

Select Input Columns

Analysis that takes results columns as input have list boxes to select the columns.

Where it is possible to make a reasonable assumption about the input for a given analysis,
Clampfit Batch Analysis automatically fills the input columns. When such an assumption cannot
be made or when the automatically selected column is wrong, you must open the input column
list box and select the column. Columns are identified by the two-level column titles used on the
results spreadsheet.

Easier than selecting input columns from the list boxes in the dialogs, however, is to preselect
the columns on the spreadsheet before you open the dialog. Use the graph X-axis and Y-axis
column identifiers for this.
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For example, if you are going to fit two columns of data, click in the first column to select it and
then click the X button in the results title bar. Select the second column and click the Y button.
When you open the Curve Fit dialog the two columns you select are set on the Data tab of the
dialog, so you can go to other configuration settings.

X and Y columns can be selected in the spreadsheet from the graph, if the columns have
already been plotted. For example, if you are fitting plotted points, click on the plot and then
open Curve Fit Columns. The X and Y columns for the plot are selected when you click on the
graph and are fed to the Curve Fit dialog when it opens.

Command History

As you apply trial editing or analysis steps, each step is recorded in the Command History on
the Analysis tab. If you apply a macro, this is reported as a single node that can be opened to
show its component steps.

Each command step is numbered. These numbers are used in the column titles of results data
written to the analysis results and dataset results sheets.

When a macro is run, the macro is numbered following the main numbering sequence, while the
steps within it are given a subsidiary number, for example, if the macro is the second command
applied to a dataset, the macro is number 2, and its component steps 2.1, 2.2, etc. If the macro
contains macros within it, the numbering goes to three levels, and so on.

Click a Command History node to bring the results from that step into view on the results sheet,
or to show the graph if it was an Add Graph or Edit Graph step.

Each Command History node stores the configuration settings for the analysis or editing step
that it represents. The settings can be viewed in the dialog used to run the step by selecting the
node and calling the Properties command (double-click, popup menu or Command History
toolbutton). It is not possible to make changes to the analysis step from a dialog opened from
the Command History. To make changes to a previous analysis step you must undo back to it
and then call the analysis dialog from the main menu to reconfigure the step.

The View Analysis Set option in the Command History popup menu identifies the trials on the
Dataset Results tab for which the analysis step was done. The database ID attributes are used
for this.

When you run a macro, the cursors in the open trial on the Trials tab stay where they are,
possibly in positions other than ones marking the baseline and search regions used in the
macro. The Show Cursor Positions command in the popup menu moves the cursors to the
baseline and search region positions used in the analysis step, provided that these regions
were defined using cursors rather than, for example, epochs.

Undo and Redo

Any number of analysis steps can be undone and, if no changes are made, redone, with the Edit
> Undo and Redo commands.

Click Undo to undo the last step that displays in the Command History. If that step is a macro,
then the entire macro is undone.

If a series of analyses have accumulated, continue to click Undo to return back to the start of
the analysis session. Click Redo all the way back to where you were. For example, do this if you
configured an analysis sequence and want to record it as a macro, undo all the way back to the
start, begin the macro, and then redo the entire sequence, recording it the second time.

Use Undo when experimenting with analysis configurations, to test a configuration, see the
results, and then step back if you want to make changes.
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Redo is available while no changes have been made to the analysis; for example, it can only be
applied to restore an Undo command if no existing analysis step has been changed, or no other
analyses have been added.

Graphs

Any spreadsheet columns that contain numeric data can be graphed as histograms, point, or
line graphs. Multiple Y-axis columns can be plotted in a single graph, even when these have
different units. Vertical tags can be added to mark X-axis values.

Many analyses automatically generate a graph of their output. If not, the easiest way to create a
graph is to select the X and Y columns in the spreadsheet, marking these as X and Y with the
red and green X, Y and Y+ buttons in the results sheet title bar (use Y+ when more than one Y
column is required). Then click Add Graph on the left of the title bar to display the Graph dialog
with the axis columns already selected, and the plot for the trial displays.

With the axes defined, use the graph configuration options to name the graph, axes and plots,
change axis settings, or add tags, or you can click OK to generate the plots for the entire
dataset.

To add a plot to an existing graph, select columns in the same way but click Append to Graph.

Linkage to the Spreadsheet

Graphs remain dynamically linked to the spreadsheet columns represented in them. Click on a
point in a graph to highlight the X and Y columns for the plot that the point belongs to, and the x
and y coordinates of the point are highlighted within this. The point itself is picked out with a
dashed cross hair in the graph.

After you select the X and Y columns of a plot, you can select other points in the plot in the
graph by clicking on the cells in the spreadsheet.

Automatic Graphing

The output of many analyses can be automatically graphed. When one of these analyses is
applied, a following Add Graph or Edit Graph step is automatically applied, plotting the output
on a new graph or appending it to an existing graph.

Save Analysis Results

To save the results of an analysis click Save Results on the Analysis Results tab results title bar,
or the Dataset Results tab title bar. All results, in both tabs, are saved, irrespective of which tab
the save command is called from. The Save Results command starts a sequence of save steps:

1. If the dataset contains trials with unsaved changes, the Save Modified Trials dialog displays
where you enter a comment to save all the modified trials as new trial versions. You must
save the modified trials in order to be able to save the results.

2. If the trials in the dataset have not been saved in a dataset, the Save Dataset dialog
displays where you enter a dataset name and add a comment.

3. After you name the new results set, it is stored under the dataset the analysis was run on
the Datasets tab.

All spreadsheet results and graphs are saved in results sets and the command history so you
have a complete record of the data that analysis was run on, the analysis steps that were
applied, the configuration, and the results themselves.

After a results set is saved it cannot be edited or deleted. It can be opened and additional
analysis commands run on it. The combined results can then be saved as a new results set.
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Any number of results sets can be saved with a dataset. They all share the dataset permission
settings.

Use the Attach File to Results Set command to save files of any type into the database,
associated with a particular results set.

Export Results

You can export analysis results as comma separated variable (.csv) or Excel (.xls) files, with the
Export Results command in both the File and Analysis menus. You can include this command as
a step in a macro to automatically export results. See Analysis Output: File Export on page 26.

Macros

Any number of commands from the Trial Editing and Analysis menus can be tied together as a
single analysis sequence and stored in a macro. Some Trial Editing commands cannot be
included in macros. These are then accessed to apply to new datasets, and to copy, edit, and
otherwise manage from the Macros pane on the Analysis tab.

Create Macros

Macros are created by recording commands as they are applied to the current dataset. Start
recording a macro from the Macro menu or Macro pane Record button.

When recording starts, a macro‐recording window opens. The window has Stop, Pause, and
Cancel buttons, and a field for the macro name, which must be entered before recording is
stopped and the window closed. The main field in the window displays the commands recorded
in the macro.

Command steps build up in the macro window in tree format, in the same way they do in the
Command History. The macro recorder is sensitive to Undo and Redo commands, so you can
record while experimenting with the details of the analysis. If you apply an analysis step you are
unhappy with you can undo it, removing it from the macro recording just as it is from the
Command History.

Frequently, the macro and Command History trees are identical, but this is not necessarily so.
Macro recording might start after some analyses have been applied. Once recording begins,
the Remove Traces and Adjust Baseline Manual commands are not recorded in macros,
though they can be applied (and hence recorded in the Command History). These commands
are applied to individual trials, for each of which they need to be configured, and so they are not
recorded in macros where they would be applied blindly to new trials.

It is possible to run a macro while recording another, incorporating the one as a step in the
parent macro. A single macro, then, could consist of a number of sub‐macros (which could
themselves contain further macros). This can be a good way to build up a store of macros; first
create small macros for short, commonly used command sequences then use these as
components of other macros.

Run Macros

To run a macro, select it and click Run. The application of the macro is recorded as a single step
in the Command History, but you can open this to see the component steps.
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Run Step

You can run individual steps of a macro with the Run Step button. If you select the first step and
click Run Step, the following step is selected after the first command is applied so you can run
through the entire macro one step at a time. You can select any individual macro step to run at
any time.

Run Step records the commands in the Command History as if it was opened from the main
menu, for example, they display as independent commands not belonging to a macro. The
advantage is that the macro step is already configured how you want it.

Show Cursor Positions

The Show Cursor Positions command in the macro popup menu shifts the cursors in the
currently open trial to the baseline, and search region boundaries defined in the selected macro
step, providing those regions are defined by cursor positions. If the regions are defined by, for
example, epoch, the cursors do not move.

Manage Macros

When a macro is first created it displays in the User folder in the Macros pane. The current
Clampfit Batch Analysis user, who created it, and administrators, are able to see it here, but no
other users. The macro itself is stored in the database, hence its availability to administrators
and the current user if they log in on another computer.

To share a macro more widely, use the Macros menu or popup menu option to copy it to the
Shared folder. Macros in this folder are available to all Clampfit Batch Analysis users. It is not
possible to share macros selectively as it is with projects, screens, and datasets.

Macros, except for those in the sample folder, can be edited insofar as the command steps they
contain can be reconfigured. Open the dialog for any of the component steps (popup menu
Properties command or Macros toolbar button) where you can change any of the settings.
When you click OK, the dialog is saved back into the macro with the new settings. Be aware of
the types of changes you make when editing macros in this way because changes that alter the
values that are output should not affect other steps in the macro, but any changes that affect
the output format, for example, creating additional columns, could break the macro, if later
steps rely on the current output format.

It is not possible to add new analysis steps to an existing macro, or to remove steps. If you want
to add or remove command steps from a macro the easiest way is to record a new macro, and
use Run Step to copy in the steps of the existing macro that you want to keep. Leave out steps
that you do not want to include, and add new steps by opening the appropriate dialog from the
Trial Editing or Analysis menu.

Macro Export and Import functionality allows you to share macros with others. Macros can be
exported to disk as .xml files and sent to a colleague, who can import the macro into their own
database. Access these options from the main Macros menu or Macros pane popup menu.

Database

The default database is BatchAnlayis.db. You can create new database files for more granular
organization. For example, you can create and use databases for individual users or projects.
To use an alternate database, you must create the new database and then select it for use. The
selected active database remains active until you select a different database. The status bar
specifies the name of the active database.
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Create Database

To create a database:

1. Select Database > Create Database.
2. In the New Database Name field, enter the database name and then click Create.
3. In the Save As dialog, select a folder location and then click Save.
4. To use the new database you created, you must select it.

Select Database

When you want to change the active database, you must select it. Creating a new database
does not automatically select it as the active database.

To select a database:

1. Select Database > Select Database.
2. In the Select Database To Use field, enter the path of or click ... to locate and open the

database file to select, then click OK.
3. On the Storage Location message, click OK to display the Storage Location Type dialog.
4. Click the + (add) button to display the Create New File Storage dialog.
5. In the Display Name field, enter the name of the data file storage folder and then click OK to

display the Storage Location Type dialog.
6. Confirm that the Available heading displays Yes.
7. Click Refresh to update Available, if needed.
8. Select your file storage entry row and click OK.
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Chapter 3: Trial Editing and Analysis Commands

In Clampfit Batch Analysis, the commands that generate new data are contained in the Trial
Editing and Analysis menus. Commands in the Trial Editing menu modify raw trace data in trials,
producing new trial versions. Commands in the Analysis menu generate spreadsheet data as
output, taking either trials or spreadsheet data as input.

This chapter lists the commands available, describing the main features of each.

Trial Editing Menu

Commands in the Trial Editing menu are divided into two lists:

Selected for Analysis: These commands can be applied, with the same configuration, to
numbers of trials in a dataset, and to new trials in other datasets, in a macro.
Selected Trial Only: These commands require independent configuration for each trial from
which they are applied.

Because of these differences, different rules are used for the application of the commands:

Selected for Analysis
Applied to all the trials in the dataset with Analyze value Yes.
Can be recorded in macros.

Selected Trial Only:
Only applied to one trial at a time, the trial that is currently open.
Cannot be recorded in macros.

Adjust Baseline Manual, and Remove Traces are the two Selected Trial Only commands.

After you edit a trial, it is updated in the dataset but not yet saved to the database. You can view
the changes you made and analyze the modified versions. When you finish the modifications
you can save them with Dataset menu Save Modified Trials.

If you save results while you have unsaved modified trials, you are required to save the
modified trials as well.

Data

Many of the Trial Editing commands allow selection of the signal and traces to be edited (some
automatically apply to all signals and traces, or to all the traces in one signal). The options
include:

Active Signal: Takes the number of the selected signal in the current trial, and then uses
that number signal in all trials, such as the first signal in each, irrespective of name.
Specify a Signal: Specify a signal name from the current trial, then the trial of that number,
not necessarily the same name, in other trials is used.
All Visible Signals: All visible signals in the current trial, and signals of the same numbers in
other trials.
All Signals (Including Hidden): All the signals in all the trials.
All Visible Traces: The numbers of the visible traces in the current trial, in all of the trials. If
later trials have more traces than the current trial, the additional traces are not included.
All Traces (Including Hidden): All the traces in all the trials.
Active Trace: The number of the active trace in the current trial, in all trials.
Select From List: The same selected trace numbers in all trials where they exist.
Specify a List: As for Select From List.

3
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Adjust Baseline Specified

Use this command to adjust traces by adding or removing a component. The most common
application is to remove an unwanted DC component or a steady baseline drift prior to further
analysis. Entire traces are corrected.

Subtract Mean Of: Computes the mean of the region and subtracts this. Use this to remove the
DC component.

Subtract Slope Of: Computes a slope of the region and subtracts this. The slope is computed
using linear regression. Use this to compensate for a steady baseline drift, in which case the
region for computing the slope is the full trace.

Arithmetic (Trials)

Use Arithmetic to perform arithmetical operations on data traces. Operations can be applied to
sections of traces.

Enter an expression in the top field to define the arithmetic operation. First enter the trace or
traces to modify, followed by an equals sign and then the operation to perform on the traces,
typically referring to the same and/or other traces in the right side of the equation.

Traces are identified with ‘t’ prefixes. You can enter these in directly, or select them with the
options below and use the Assign button. Operators and functions can be entered in or
selected from the lists.

Descriptions of the functions and constants available for Arithmetic expressions are given in the
Analysis menu Arithmetic section. See Arithmetic on page 41.

Average Traces

Use the Average Traces command to select traces to average in a trace display or by trace
number in a list. The averaged trace is added as a further trace at the end of the trial,
immediately following the last acquired trace.

You can output a further trace of the standard deviation.

The currently open trial displays in the dialog, where you can choose which, or all, signals to
view. When the command is applied, the selected traces in all signals are averaged.

The same trace numbers are averaged in each trial selected for analysis across the dataset.

To help with trace selection you can drag along the graph axes in the graphical display to zoom
in, and use buttons for other scaling options. To help select closely packed traces, use the
vertical separation option to space traces apart. If you select an incorrect trace, you can undo
the selection. Only one selection can be undone.

Filter

The Filter dialog has options for Highpass, Lowpass, Bandpass, electrical interference, and
notch filtering. A diagram that represents the cutoff characteristics of the filter displays in the
lower right‐hand corner of the dialog.

You can also filter a selected region of the traces, or entire traces.

The sampling frequency, sampling interval, and number of data points per trace are reported at
the bottom of the dialog. See Digital Filters on page 53.
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Electrical Interference

The Electrical Interference filter identifies and removes complex 50 or 60 Hz power line
waveforms, composed of multiple harmonics.

The filter is designed for long continuous data files of several seconds or more and does not
work well with short files.

The EI filter will be disturbed and take time to recover after a transient signal that has harmonics
overlapping the harmonics of the steady‐state interference signal. The disturbance takes the
form of an introduced cyclical noise that lasts for the duration of the Cycles to Average
parameter.

You can specify the highest harmonic of the interference waveform to remove. It is often
sufficient to remove only the first harmonic, or the first few harmonics, resulting in faster
execution speed.

The cycles to average control specifies the time constant of the filter, expressed in line
interference cycles (periods). In case of 50 Hz line voltage, one unit is 20 ms, while in case of 60
Hz it is 17 ms. The filter removes interference more effectively with a higher number of
averaging cycles, at the expense of execution speed.

The reference frequency must be the same as the power line interference frequency. If Auto is
selected the EI filter automatically determines the frequency so long as it is either 50 Hz or 60
Hz. Use Auto when you are not sure of the interference frequency.

Force Values

This command modifies the contents of a selected region of the selected traces. Use this to
eliminate the effect of transients before lowpass filtering.

The analysis applies to all Analyze ‘Yes’ trials in the dataset. T to remove a transient in one trial
only, be sure to select it alone for analysis.

The region selected in the Region To Force takes the values configured in the main section of
the dialog. You need to position cursors in the current trial for use in the configuration options in
the dialog.

In typical usage to remove a transient peak, position cursors 1 and 2 on either side of the peak
and then in the dialog select cursors 1 and 2 as the region to force, and straight line between
cursors 1..2 as the new value. A straight line is drawn between the cursors, eliminating the peak.

Subtract Last N Trace Average

This command takes the last N traces in each trial and averages these. Then the averaged trace
is subtracted from each trace in the trial. The averaged trace is not itself written, so the resulting
trial has the same number of sweeps as the original.

Subtract Last N Trace Average applies to all traces in all signals.

Time Shift

Use Time Shift to change the alignment of the data with respect to the time base. The
operations of this option either align the data peaks or shift the data traces by a specified
amount along the time axis. You can rotate points when traces are shifted, or replace these
points with zeros.
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Adjust Baseline Manual

Use Adjust Baseline Manual to adjust for baseline rundown manually. The dialog opens to
display one signal of the trial. You can change the signal in the top right list. Use the cursor to
drag the purple baseline marker as appropriate. All traces in the signal are adjusted to the new
baseline when the dialog closes.

Remove Traces

Use Remove Traces to select traces to remove a trace display, or by trace number in a list. It can
only be applied to individual trials, and is not included in macros.

The open trial displays in the dialog, where you can choose which (or all) signals to view. When
the command is applied, the selected traces in all signals are removed.

Selected traces are highlighted, accumulating as you select additional traces. To update the
view by removing those traces already selected, click OK and then reopen it.

To help with trace selection, drag along the graph axes in the graph display to zoom in, and use
buttons for other scaling options. To help select closely packed traces, use the vertical
separation option to space traces apart. If you select an incorrect trace you can undo the
selection. Only one selection can be undone.

Analysis Menu

Commands in the Analysis menu are all macroable, and output their results to spreadsheets on
the Analysis Results or Dataset Results tabs. See Analysis on page 24.

In the menu, various ‘special‐case’ commands display in their own sections, while the remaining
commands are divided into three sections:

The group starting with Measurements all apply to trials. These commands take some sort
of measurement from data traces.
You can select particular signals and traces to which to apply these commands (depending
on the analysis). See Data on page 33.
The group starting with Arithmetic takes spreadsheet columns as input.
You can select the input columns from lists in the analysis dialogs when you open them, but
it is more convenient to select the columns in the spreadsheet first, marking them as X and
Y columns with the spreadsheet buttons. These columns are then populated in the dialog
when you open it.

The following describes individual Analysis menu commands.
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Get Attributes

This command retrieves attribute values from the database and writes them to results sheets.

If you call Get Attributes when the Trials tab is in view you must select whether to write the
attributes you will select to the Analysis Results sheets (per trial) or to the Dataset Results tab.

The dialog closely resembles the Data Selector tree configuration dialog, and the list column
configuration dialogs. The list of all database attributes display in the left‐hand field, which you
select by moving them to the right‐hand field.

Each selected attribute is written to its own column in the results sheets. Depending on the
scope of the attribute, it will have a different number of values. For example, Trial attributes
such as Trial: Ra or Protocol have as many values as there are trials.

By default, the Repeat Values To Align Rows checkbox is available. If single-value attributes
are selected along with trial attributes (like Protocol, or Acq. Sweeps), of which there may be
many, the single attribute is repeated to align with the rows of the trial attribute. If this checkbox
is clear, then the single-value attribute is written once only. Single-value attributes can be
repeated to align with multiple trial attributes.

When attributes are written to the Dataset Results tab, trial values are automatically written as
well, so that you can identify where particular values came from within the columns.

Add Graph/Edit Graph

The Graph dialog provides multiple plots, histograms, and tags, and configuration options. As
you configure a graph, a display in the bottom of the dialog displays a preview of how it will
look. See Graphs on page 28.

The most important selection of X and Y columns to plot is performed on the Plots tab. Very
often, with automatic graphing, these are automatically selected, or it is most convenient to
select X and Y columns directly in the results sheet before opening the dialog. Otherwise,
select X and Y values from a listing of all results columns in the appropriate list boxes.

To add additional plots to a graph, click Add under the Plot field on the left of the tab. Name it
on the right, and then select the X and Y values.

Error bars are added to a graph by selecting a column, for example, of standard deviation
values for an average value selected for the Y‐axis.
After you define a plot, use the Plot Properties section on the Plot tab to define its appearance.

The General tab has graph naming, legend, gridline, and border configuration options. For
graph names you can enter a name, to appear on all graphs, or select a results sheet column.

The Axis tab allows you to name graph axes, including units, and has many other configuration
options including log and inverted scales, zero-crossing axes, and showing time in minutes.

You can define set axis ranges that apply to all the graphs generated, or select the Show Zero
checkbox to include zero in the axis range.

Tags are defined by selecting the X‐axis values to be marked, by selecting the results sheet
column. Any column can be selected to label the tags If labels on successive tags are repeated,
only the first displays.

Tags can grouped using a third attribute. The tags are then color‐coded according to their
group, and the grouping value used in the graph legend.

If no grouping is selected you can enter text for the legend entry for the tags.

Configuration options for the appearance of tags, which can be either full‐height lines down the
graph, or arrows at the bottom, are on the right on the Tags tab.
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Measurements

The Measurements command can take different measurement types from up to eight different
time regions within trials.

On the Measurements tab, select the number of different searches to configure with the Search
Number spinner and checkbox. The configuration options on the Measurements tab is available
for each search that you enable, for example, for each search you can set:

Search region (using cursors or epochs)
Baseline region (or set a fixed baseline value)
Measurement types
Peak polarity
Smoothing

Two options are included to input Measurements settings used during acquisition for example,
in the Clampex Software) into the dialog:

Import From File: This copies the acquisition measurement settings from the currently open
trial into the dialog. All options remain enabled so you can alter them if you like.
Use Acquisition Measurement Settings: This checkbox disables the Measurements tab.
When the analysis is run, the acquisition measurements settings for each trial are used. If
different acquisition measurements were taken from different trials in the dataset, different
measurements are taken from these.
Use Acquisition Measurements Settings does not populate the Measurements tab with the
measurements taken on the currently open trial. To see these first click Import from File,
and then select the Use Acquisition Measurement Settings checkbox.

Output Options

Since measurements from all the trials are written to the same results sheet, this option
determines the placement of these relative to one another. Under the Columns option,
measurements from each trial are placed in new columns beside one another. Under the Rows
option, measurements in following trials are added under those from previous trials, in the same
columns.

Write data source information writes a number of values to identify the input of the
measurements step.

Automatic Graphing Parameters identifies the columns selected for plotting in an automatic
graphing step following the application of the Measurements command. In most cases you
should be able to accept default settings here.

Measurement Types

Descriptions of the measurement types are given below.

Peak Amplitude: Finds the peak amplitude relative to the baseline, dependent on the peak
polarity setting.
Time Of Peak: Reports the time of the peak, from the start of the sweep, as well as from the
start of the trial. Both measurements are automatically output, even if not requested, for
automatic graphing purposes.
Anti‐Peak Amplitude: The point furthest in amplitude from the peak.
Time Of Anti‐Peak: Reports the time of the anti‐peak.
Mean: Average of the amplitude of all sample points in the search region.
Standard Deviation: The standard deviation of the amplitude of all the sample points in the
search region.
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Area: The area bounded by the trace and the baseline, in units of (amplitude × time). In the
case of bipolar events the negative area is added to the positive area, so a total area of
zero is possible.
Area is calculated using simple summation of points within the search region. For example,
with a search region from sample ten to sample sixteen, the sample‐to‐baseline amplitudes
of each of the seven sample points in the range are summed, and multiplied by the
sampling interval.
Half‐Width: To find the half‐width the points to the left and right of the peak are scanned
until the points (nearest the peak) that are 50% of the peak amplitude relative to the
baseline, are found. The time between these two points is the half‐width.
If the samples on one side of the peak never get down to 50% of the peak amplitude within
the search region no half‐width is found.
Maximum Rise Slope: Finds the greatest rising slope (for example, moving towards the
peak) between two sample points in the region bounded by the start of the search region
and the peak. If two sections of trace have the same increase rate the section nearest the
peak is reported.
Time Of Maximum Rise Slope: The midpoint between the two points during which the
maximum rise occurred.
Maximum Decay Slope: The greatest falling (for example, returning to baseline) slope
between two sample points in the region bounded by the peak and the end of the search
region. If two sections of trace have the same decay rate the section nearest the peak is
reported.
Time Of Maximum Decay Slope: The midpoint between the two points during which the
maximum decay occurred.
Slope: The slope within the search region, as found by linear regression.
Baseline: If you specify a mean level for the baseline region, the averaged baseline value
for the trace in the stipulated region is reported. Otherwise the fixed baseline is reported.
Rise Slope: The slope, from within the region bounded by the start of the search region and
the peak, between the points determined by the associated from and to percentiles. Points
to the left of the peak are scanned until points at the nominated percentages of the peak
amplitude (relative to the baseline) are found. Regression is applied to these and all
intervening points to give the rise slope (see Figure 3-1).

Figure 3-1: Rise slope from 20% to 80%.

If the samples on the left side of the peak do not get down to either of the nominated
percentages before the left boundary of the search region, the rise slope is not found.
Rise Time: The time between the associated from and to percentile points (see Rise slope
above for how these points are determined).
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Decay Slope: The slope, from within the region bounded by the peak and the end of the
search region, between the points determined by the associated from and to percentiles.
Points to the right of the peak are scanned until points at the nominated percentages of the
peak amplitude (relative to the baseline) are found. Regression is applied to these and all
intervening points to give the decay slope (see Figure 3-2).

Figure 3-2: Decay slope from 80% to 20%.

Decay Time: The time between the associated from and to percentile points (see Decay
slope above for how these points are determined).
Event Duration: The time difference between the beginning and the end of the response
determined by the percentage of the peak amplitude (see Figure 3-3).

Figure 3-3: Event duration at 20%.

Current/Voltage

Current/Voltage finds the stimulus waveform voltage at a point or region of the trials it is applied
to, and measures the current at another (or the same) point or region.

Configuration of I‐V and H‐infinity plots is straightforward with the command—identification of
voltage settings with the X‐Axis and current settings with the Y‐Axis reinforces this. As with
other commands, if you use automatic graphing (Program Options in the Configure menu) the
plot will be automatically generated after you apply Command/Voltage.

With the waveform signal identified, the voltage can be taken at a specific cursor position, or
from an epoch. If the command signal is included as a signal within the trial, the voltage can be
read from this as well.

The X‐Axis measurement is not limited to voltage only. The epoch duration can also be used, as
well as any user list values you set.

Current measurement from a selected signal can be taken at a single point, or be the mean or
peak within a defined region. The command has an optional boxcar filter to smooth points in the
traces before taking the current measurement. You can set the number of points smoothed.

Both the voltage and current measurements can be inverted. Current/Voltage measures current
from one signal at a time.
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Curve Fit Trials

Use Curve Fit Trials to fit to selected regions of selected data traces in trials.

Not all predefined functions are available for fitting trace data. Functions with more than one
independent variable or negative X‐axis values can only be fitted to results sheet data. All
configuration options in the dialog are not available when you select a non-applicable function.

The number of data points between the cursors cannot exceed 110,000.

Curve Fit Trials uses the same dialog as Curve Fit Columns, with the Data tab modified for
selection of traces rather than columns. See Curve Fit Columns on page 43.

Histogram Trials

Histogram Trials bins individual data points by amplitude. You can apply the command to
signals and traces, and to a region of the trace you set on the Data tab.

In other respects, Histogram Trials is the same as Histogram Columns. See Histogram Columns
on page 47.

Trace vs. Trace

Use Trace vs. Trace to plot the points of a single trace against points at the same time of the
sweep in another trace. Comparison can be made between traces in the same or different
signals within each trial. You can apply the analysis to the entire sweep length or a specified
region.

Arithmetic

The Arithmetic command in the Analysis menu applies to results sheet data on the Analysis
Results or Dataset Results tabs, unlike its close relative in the Trial Editing menu, which applies
arithmetic to traces in trials.

In the Analysis menu command output is always to a single new column in the results sheet,
therefore you only enter the right‐hand side of the arithmetic equation.

Use capital letters to identify results sheet columns, as shown in the main field in the dialog, or
select a column and click Assign to write it into the expression. Enter functions, operations or
constants directly into the expression or select these from their lists.

Only columns with the same number of rows can be combined in Arithmetic. You can limit the
input to a specific row range. The same row range is applied to all the columns used in the
expression.

The Arithmetic command is unique in Clampfit Batch Analysis in that it allows you to write the
second row title for the output column. Leave this blank to have the title default to the arithmetic
expression. Use this to write a meaningful description as the column title, making it easier to
understand results for review.
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The following functions are available in Arithmetic:

Function Description

arcos( ) Arccosine: the inverse cosine of a number in the range of –1 to +1. The result is in radians.

arsin( ) Arcsine: the inverse sine of a number in the range of –1 to +1. The result is in radians.

artan( ) Arctangent: the inverse tangent of a number in the range of –1 to +1. The result is in radians.

Cannot be used with odd multiples of∏/2.

cos( ) Cosine: the cosine of a number in radians.

diff( ) Differentiate: the derivative. The result is strongly affected by noise in the data; consider

filtering before use.

exp( ) Exponentiate: e raised to the value of the number.

intg( ) Integrate: the continuous integral. The result is strongly affected by the baseline.

inv( ) Inverse: the multiplicative inverse.

ln( ) Loge: the logarithm to the base e. Cannot be used with zero or negative numbers.

log( ) Log10: the logarithm to the base 10. Cannot be used with zero or negative numbers.

norm( ) Normalization: the data are scaled and offset to a Y‐axis range of 0 to 1.

normax() Normalization: the data are scaled by being divided by the largest value in the column.

normin() Normalization: the data are scaled by being divided by the smallest value in the column.

ramp( ) Ramp: the data are scaled by a steadily increasing factor from 0 to 1.

rect( ) Rectify: replace numbers with their absolute values.

sin( ) Sine: the sine of a number in radians.

sqrt( ) Square root: the square root. Cannot be used with negative numbers.

tan( ) Tangent: the tangent of a number in radians.

Table 3-1: Arithmetic Functions Descriptions

Available in the Constants list:

Constant Description

time the time value of the point.

maxtime the maximum time of the destination trace

pi pi
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Average Rows

Use Average Rows to find the arithmetic or geometric mean, and/or the median, of a selected
column. Standard error, sample and population standard deviations, and sample size can all
also be derived.

You can isolate particular values in the column selected for averaging by reference to the
values in one or more other columns.

Curve Fit Columns

Use Curve Fit Columns to fit results sheet data or graph plots.

The dialog has four tabs:

Function: Select the fitting function, basic settings and model comparison to find the best
number of terms.
Advanced: Fitting methods, preprocessing and fitting strategy, as well as output
information options and fit extrapolation. Many of these settings can be set automatically or
left at defaults.
Seed Values: Entry of seed values and graphical seeding.
Data: Selection of the columns to be fitted.

The formula of the selected function displays at the bottom of the dialog, visible from all tabs.
The formula name and other information are reported in a Status Bar above the formula. See
Curve Fitting on page 77, and Fitting Functions on page 105.

Function Tab

Select the fitting function from the list or configure your own custom function. The predefined
functions are divided into groups to make it easier to find.

Find Best Number of Terms

For functions that support multiple terms, use the compare models option to find the best
number of terms at a specified confidence level. With automatic searching, models for up to 6
terms are tested. For least squares fitting the confidence level refers to the F-statistic. For
maximum likelihood fitting it refers to the Chi-square statistic.
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Custom Function

You can enter a fitting function of up to 255 characters in the Custom Function field. An
example displays in the dialog. See Define a Custom Function on page 100.

The following operators can be used in custom functions:

abs absolute value log the logarithm to

the base 10

acos arccos log10 the logarithm to

the base 10

asin arcsine pow10 10 to the power

atan arctangent ramp scale by a

steadily

increasing factor

from 0 to 1

cos cosine random random number

generator

(requires dummy

variable)

diff differentiate rect absolute value

exp exponential round round up to the

nearest integer

fact factorial sin sine

intg integrate sqr square

inv reciprocal (1/x) sqrt the square root

ln natural logarithm (for example, log to the base e) tan tangent
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Advanced Tab

Search, minimization and weighting methods are configured on the Advanced tab, as are other
fit application and output options. Also see .

Tip: Unexpected application of zero-shift is a common cause of failed or inappropriate
fits. Always check this first, in the Status Bar above the formula, in these cases.

If you fix parameters and these are not at the fixed values when the fit is completed,
check to see if the Auto-Free Fixed Parameters and Refit function is on.

The following Advanced tab options are available for enabling:

Zero-Shift X-Axis Data: A set of i data points xi, each point x is offset such that x = xi – x0
where x0 is the value of the first data point (the fitting origin). If data are to be offset, the text
(zero-shift) appears in the options Status bar in the fitting dialog immediately above the
equation window.
Auto-Free Fixed Parameters and Refit: Automatically frees fixed parameters following
convergence and the fit is reapplied with all parameters free.

Tip: Turn this option off to keep fixed parameters fixed following convergence.

Attempt Refit on Failure: Seed values are automatically adjusted (up to six times in each
direction) and the fit reapplied in the event of fit failure. This often results in a successful fit
even if the original seed parameters were well off the mark. No indication of parameter
readjustment is provided.
Extrapolate Fit: Fits can be extrapolated beyond the range of the data fitted. For trials, set
cursors 1 and 2, or 3 and 4, to the region you want to extrapolate the fit to. For fits to results
data, specify the X-axis limits for the extrapolated fit. The number of samples in the
extrapolation range plus the fitting range cannot exceed 110,000.
Zero Concentration Replacement: Allows the Curve Fitting dialog to accept zero
concentration as an input even though concentrations are in a log distribution, and hence
zero strictly disallowed. In these cases zero is replaced by a number n times smaller than
the least actual concentration.

Search Method

The following search methods on the Advanced tab can be set automatically or manually:

Levenberg‐Marquardt: Uses an iterative approach to minimize the difference between the
fitted curve and the data. See Levenberg-Marquardt Method on page 79.
Variable Metric: Is an iterative search method that relies on the evaluation of derivatives
with respect to each parameter. The method can be slow when fitting to very large data
sets but in most cases converges quickly with data sets that are well described by the fitting
function. See Variable Metric Method on page 83.
Simplex: Uses an iterative technique that does not require evaluation of derivatives. This
method requires more iterations to converge than the Levenberg–Marquardt or variable
metric methods, however, it is less prone to convergence on a local minimum. See Simplex
Method on page 81.
Chebyshev: Transforms the data to fit to the Chebyshev polynomial domain before the
errors between the fitting function and the data are minimized. It is a faster fitting method
than the other options, but the data points must be equally spaced. See Chebyshev
Transform on page 84.
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Precision

The precision value is a tolerance level for convergence. The lower the value the more readily
the fit converges. Very low values might result in convergence even though the fit is poor. High
values might result in very slow or no convergence.

The following default values provide a good compromise between speed of convergence and
fitting accuracy:

Levenberg‐Marquardt: 10–6

Variable metric: 10–4

Simplex: 10

4 pt. Smoothing Filter

A 4‐point smoothing filter can used with the Chebyshev fit. This filter reduces noise and
nonlinear noise effects on the statistics of the fit. The averaging does not alter the accuracy of
the fit but it can alter the value of the fitted parameters if the data are noisy. If in doubt as to
whether or not to use this filter, fit both with and without the filter and accept the best fit on the
basis of the fitting statistics.

Seed Values Tab

The seed values on the Seed Values tab are used for the curves in the Graphical Seeding
window. If the function has multiple terms, the component curve for each term displays. The
curve that represents the complete function, the sum of the terms, is the function curve. Each
individual component curve and the function curve display along with the data. The function
curve always displays, whereas the components curve display is optional.

Seed values are assigned to the parameters by entering a value directly in the field or by using
the spinner. There is a short delay before the graph updates with the new seed parameter
values.

Enter all search methods, except the Chebyshev, linear, or polynomial regression, function
parameter seed values before fitting. For the Chebyshev method, seed values are computed
but must be fixed.

The fitting routine automatically generates seed values for all predefined functions and enters
these values on the Seed Values tab. Seed values must be entered manually for custom
functions.

Individual parameters can be fixed using the Fix option next to each seed value. When a
parameter is fixed, the value is a constant term in the fitting function.

Tip: Often a difficult fit can be made by fixing one or more of the function parameter
values.

When you use Advanced > Auto‐Free Fixed Parameters and Refit, the fixed parameters are
automatically freed upon convergence, and the fit repeats. See Advanced Tab on page 45.

For custom functions, none of the seed values can be zero. You must assign non-zero values to
each parameter for fitting to continue.

Tip: For zero value parameters, either remove it from the function, or specify a very low
value, such as 0.00001.
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The following options are available:

Force Parameters Positive: Generates only positive amplitudes.
Force Proportions Positive: Generates only time constants.
Constant: Most predefined functions have a constant Y offset term ‘C ’. This value is
automatically estimated but can be modified or fixed like any other parameter. A value of
zero can be assigned to this parameter.
Slope: The Exponential, Sloping Baseline function is the only option that has a slope term.
The seed value for this term is initially automatically estimated. A value of zero can be
assigned to this parameter.
Proportion Display: Displays the proportion terms either as absolute values or normalized
proportions. This option is available only for exponential probability functions.
Multiple Fit Seeding: When fitting multiple traces or columns in different trials, the initial
seed values apply to the first trace or column only.

Seed I independently For Each Fit: The seed estimates are automatically and
independently generated for each trace. Use if the successive traces are very different
from each other.
Use Results Of Current Trace To Seed Next: The fitted parameter values of the current
fit are used to seed the next.

Tip: There can be instances where the automatic seed estimation is not sufficiently
accurate to generate a successful fit, especially if the data are sparse, or not well
described by the fitting function. Where seed estimates are critical, or where reasonable
seed estimates are not automatically generated, graphically assisted seeding can be
used to produce very accurate initial values.

Histogram Columns

Bin selected columns of data for display in histograms with this command.

Select the columns to bin on the Data tab, where you can restrict the input to a specific row
range.

If you select multiple columns these are binned separately by default, but you can pool all the
values together with a Combine Histograms option (similarly, data from multiple traces and/or
signals can be pooled for Histogram Trials).

The dialog allows configuration of conventional, cumulative, logarithmic and variable width
cumulative plots.

For conventional and cumulative plots you can set either the number of bins or their width, and
the other value is automatically calculated. These values are derived using the full data range,
which you can limit, if you wish, in the Data Limits section of the dialog (this is a further limitation,
by data value, to the row limitation option on the Data tab).

Conventional and Cumulative plots can be normalized by area.

Logarithmic histograms scale the parameter of interest on a base 10 log scale along the X-axis.
All values must be greater than zero or logarithmic graphs. Bin width is set with the Bins/Decade
value, which determines the number of bins between each whole number in the X-axis
logarithmic scale.

With variable width cumulative graphs (also sometimes referred to as cumulative unbinned) the
bin width is determined by the value of the data. A scatter plot is created where each point
represents, on the Y-axis, the number of data less than or equal to the X-axis value of the point.
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Normalize Columns

Normalize Columns normalizes the values in a selected column. You can normalize between 0
and 1, or if the data you are normalizing are negative (for example, negative-going peaks) and
you want to retain this, you can normalize between –1 and 0, the lowest value going to –1 and
the highest to 0.

Additional columns can be normalized at the same time as the principal column, in which case
they are normalized to the same range as the principal column. Since values in additional
columns might lie outside the range of the principal column values, the output columns for the
additional columns might lie outside the range 0 to 1 or –1 to 0.

Copy to Dataset Results

The Copy to Dataset Results dialog copies data from the Cell Procedures tab results sheets to
the Dataset Results tab.

Analysis on the Cell Procedures sheets proceeds per cell procedure, for example, all steps are
applied within the respective cell procedure sheets. At some point of your analysis you may
want to bring data from the individual cells together, for example to average the results from
replicates, or simply to have a convenient report of final results from each cell, in one location.

To select columns to bring to the Dataset Results tab, double-click on them in the left-hand field
in the dialog. The selected columns are added to the right-hand field, where you can order them
with the arrow buttons in the right margin.

The contents of a column are copied from the cell procedure sheets and written in one column,
the values from each cell procedure placed underneath one another in succeeding rows.
Columns with different numbers of rows on the cell procedures sheets, then, generate output
columns with different numbers of rows, and the rows in different columns only align if they
came from columns with the same number of rows.

If any of the cell procedures did not have a value in a column, the blank cell is written to the
Dataset Results sheet.

The same cell procedure order is used down the columns for all columns that are copied.

As a quick illustration of these rules, if there are 10 cell procedure sheets and a column with one
row is selected, a single column with 10 rows is output. If a column with four values per cell
procedure is copied then a column with 40 rows is generated. The four values from the first cell
procedure are at the top of the column, followed by the four values from the next, and so on.
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Chapter 4: Configuration

Clampfit Batch Analysis functionality is part of the pCLAMP software Advanced Analysis license.
After the pCLAMP software is installed, Clampfit Software requires file server and data storage
configuration to use Clampfit Batch Analysis functionality.

Note: To run Advanced Analysis Clampfit Software, which includes Batch Analysis
functionality, you must have the Advanced Analysis Clampfit Software USB dongle
installed on you computer.

Use the following configuration procedures.

Configuring MDC File Server

The MDC File Server computer requires enough hard drive space to store your data files. You
can change the storage location if it becomes full. The database keeps track of data files in
multiple storage locations. If you set a new storage location, keep the existing data storage
location. Before you start Clampfit Software to run Batch Analysis the first time, you must
configure MDC File Server. MDC File Server is required to manage imported data. The MDC File
Server must be running for Clampfit Software Batch Analysis to run.

To configure MDC File Server:

1. After you install the pCLAMP software,open the MDC File Server Manager from Start > All
Programs > Molecular Devices > MDC File Server > MDC File Server, right-click and select
Run As Administrator.

2. In the MDC File Server Manager dialog, click Select File Directory.

Note: If you select a computer other than the local one, the software must have
access permissions to the folder location at all times.

3. Click Create New Folder.
4. In the Name field, enter the name of the file server and then click OK.
5. In the Select Port field, enter 9200 and then click Apply.
6. Click Start and wait for the Start button to become inactive.

4
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7. When the Start button is inactive, click Close.

First Time Use Database Configuration

The first time you use Clampfit Software Batch Analysis, you must do the following to configure
the data storage folder:

1. Ensure that the Clampfit Software license key dongle is installed on the same computer that
the software is installed.

2. Start Clampfit Software.
3. Select Analyze > Batch Analysis to display the Batch Analysis window.
4. When the Storage Location message displays, click OK to display the Storage Location

Type dialog.
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5. Click to display the Create New File Storage dialog.

6. In the dialog, do the following:
a. In the Display Name field, enter the name of the data file storage folder. See

Configuring MDC File Server on page 7.
b. In the Server Name field, verify that the name of the computer (local computer name) is

correct.
c. In the Port field, leave the default setting as 9200.
d. Click OK to display the Storage Location Type dialog.

7. Confirm that the Available heading displays Yes.
8. Click Refresh to update for Available, if needed.
9. Select your file storage entry row and click OK.
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Chapter 5: Digital Filters

In digital signal processing a system is something that operates on one or more inputs to
produce one or more outputs. A digital filter is defined as a system (in the case of Clampfit Batch
Analysis, a software algorithm) that operates on digitized data to either pass or reject a defined
frequency range. The objective of digital filtering is to remove undesirable frequency
components from a digitized signal with minimal distortion of the components of interest.

There will be instances when it is necessary to filter experimental data after they have been
digitized. For example, you might want to remove random noise or line frequency interference
from the signal of interest. To this end, Clampfit Batch Analysis offers several types of digital
filters.

The lowpass filters include Bessel (8-pole), boxcar, Butterworth (8-pole), Chebyshev (8-pole),
Gaussian, a single-pole RC and an 8-coincident-pole RC. The highpass filters include Bessel (8-
pole) and 8-coincident-pole RC. The Gaussian and boxcar filters are finite impulse response
(FIR) filters while the Bessel, Butterworth, Chebyshev and RC filters are infinite impulse
response (IIR) filters.

A notch filter is available to reject a narrow band of frequencies and an electrical interference
filter is provided to reject 50 or 60 Hz line frequencies and their harmonics.

Finite vs. Infinite Impulse Response Filters

Digital filters can be broadly grouped into finite impulse response (FIR) filters and infinite
impulse response (IIR) filters. FIR filters are also referred to as nonrecursive filters while IIR filters
are referred to as recursive filters.

The output of FIR filters depends only on the present and previous inputs. The general
‘recurrence formula’ for an FIR filter, which is used repeatedly to find successive values of y, is
given by:

where yn is the output value for the nth point x and bk is the kth of M filter coefficients. In the case
of the Gaussian and boxcar filters in Clampfit Batch Analysis, the M points ahead of the current
point are also used, giving a general recurrence formula of:

where the filter width is 2 x M + 1 points.

The disadvantage of FIR filters is that they can be computationally inefficient as they might
require several tens, hundreds or even thousands of coefficients depending on the filter
characteristics.

The advantages are that FIR filters are inherently stable because there is no feedback and they
possess ideal linear phase characteristics, exhibiting no phase distortion. That is, all frequency
components passing through the filter are subject to the same pure time delay.

On the other hand, the output of IIR filters depends on one or more of the previous output
values as well as on the input values. That is, unlike FIR filters, IIR filters involve feedback. The
general recurrence formula for an IIR filter is given by:

5
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where a and b are the N and M filter coefficients, where a represents the feedback coefficients.
The value of y for a given point n depends on the values of previous outputs yn–1 to yn–N as well
as the input values x.

The major advantage of IIR filters is that they are computationally more efficient, and therefore
much faster, than FIR filters. The disadvantages are that IIR filters can become unstable if the
feedback coefficients are unsuitable, and recursive filters cannot achieve the linear phase
response that is characteristic of FIR filters. Therefore, all IIR filters introduce a phase delay to
the filtered data.

The problem of potential instability of IIR filters is solved in Clampfit Batch Analysis by limiting
the cutoff frequencies for all filter types to a range where the response is always be stable (see
Cutoff Frequency Limitations on page 74). However, the phase delay is not corrected.

The Nyquist rate has important consequences for digital filtering in that the maximum analog
frequency that a digital system can represent is given by:

where T is the minimum sampling interval and fh is the Nyquist frequency.

As a consequence of this, the maximum filter cutoff frequency of digital filters is limited to one-
half the sampling rate. That is, the ratio of the cutoff frequency to the sampling rate (fc/fs) cannot
exceed 0.5. In fact, only the Gaussian and single pole RC filters can realize an fc/fs ratio as high
as 0.5; the Bessel, Butterworth, Chebyshev and notch IIR filters are limited to values that are
somewhat lower than this because of performance degradation at higher fc/fs ratios (see Cutoff
Frequency Limitations on page 74).

The fc/fs ratio limitation should not present a problem if antialias filtering and oversampling are
judiciously applied. For example, with a lowpass antialiasing filter cutoff of 4 kHz and a sampling
rate of 40 kHz, an fc/fs ratio limited to as low as 0.1 allows a maximum cutoff frequency of 4 kHz,
which is well above any useful cutoff frequency that might be applied to this particular digitized
record.



Chapter 5: Digital Filters

5061586 E 55

Digital Filter Characteristics

An ideal filter would have a rectangular magnitude response with no attenuation in the
passband and full attenuation in the stopband. However, ideal filters are noncausal in that the
present output depends on future values of the input. They are, therefore, not realizable.
However, realizable digital filters can approximate ideal filters in that the output can be delayed
for a finite interval until all of the required inputs have entered the system and become available
for determination of the output.

Different filter types optimize different characteristics of the ideal filter that they are meant to
approximate. Therefore, the application of a particular filter type should be carefully considered
in view of the specific requirements at hand.

Most filters introduce a time lag between the input and output signals. Depending on the filter
type, some frequencies are subjected to a greater lag than others. As a consequence the
output signal is distorted to some degree. This distortion takes the form of ‘ringing’ and
‘overshoot’ in the filter output given a step function input (for example, a square pulse). Filters
that introduce equal time lags for all frequencies are said to have a constant ‘group delay’. Such
filters exhibit minimal ringing and overshoot. A filter can be characterized by its cutoff frequency
and steepness of response. In the Clampfit Batch Analysis filters, the cutoff frequency is defined
as the frequency at which the signal amplitude decreases by a factor of 2. This corresponds to a
drop in power of 1/√2, or –3 decibels (dB). The steepness of a filter, its ‘roll off,’ defines the rate
at which a signal is attenuated beyond the cutoff frequency. It is desirable to have as steep a roll
off as possible so that unwanted frequencies are maximally attenuated. However, filters that are
designed for maximally steep rolloffs necessarily sacrifice constant group delay characteristics,
and therefore exhibit ringing and overshoot. The steepness of a filter response is also a function
of its order (number of poles): the higher the filter order, the steeper the response. Apart from
the single pole RC filter, the IIR filters in Clampfit Batch Analysis are 8-pole realizations.

End Effects

All software filters exhibit ‘end effects’ at the beginning or end of a data record. In the case of
the boxcar and Gaussian filters, end effects occur at both ends of the record because these
filters use both previous and succeeding points to filter the current point. Clearly, at the
beginning of the record only succeeding points are available. These filters are, therefore,
phased in progressively as previous points become available. Towards the end of the record
fewer and fewer following points become available so the filter is progressively phased out. The
filter coefficients are adjusted during these phases in accordance with the available number of
points.

Filters with fewer coefficients exhibit shorter end effects as the full operating width overlaps a
fewer number of points. The number of settling points required for the Gaussian and boxcar
filters is (filter length – 1) / 2. In the case of the Gaussian the filter length is equal to the number
of coefficients while in the case of the boxcar the filter length is equal to the number of
averaging points.

IIR filters exhibit startup-transients only. Since these filters do not use points ahead of the
current point for the filter output there is no phaseout transient. The output of these filters
depends on previous outputs as well as the current input. Therefore, a certain number of points
must be processed before these filters reach stability.

The rise time (Tr) of a lowpass filter can be estimated from Tr = 0.35/fc. As the filter settles to
within about 10% of its final value in one rise time, a duration of 3 x Tr is sufficient to allow the
filter to reach 0.1% of its final value, requiring about (3 x 0.35 / fc) x fs points.
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Bessel Lowpass Filter (8 pole) Specifications

10% to 90% step rise time: 0.3396/fc

Maximum overshoot: 0.4%

Attenuation: 114 dB at f = 10 fc

A Bessel lowpass filter has a maximally flat response over the entire frequency range (constant
group delay characteristics), exhibiting minimal overshoot and ringing in response to a step
function. As all frequencies are delayed equally the shape of the original signal is preserved.
Because of these characteristics, Bessel filters are most commonly used for time-domain
analysis of biological data, where the preservation of the shape of the original signal is critical.

Expected vs. Observed Overshoot
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Expected vs. Observed Rise Times

Normalized Frequency Response
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Boxcar Smoothing Filter Specifications

Smoothing filters are generally used to remove high-frequency components from slowly varying
signals and are therefore lowpass filters. The boxcar-smoothing filter uses the average of the
current point and a given number of previous and succeeding points to replace the value of the
current point. The recurrence formula for a boxcar filter is:

where xn is the nth point to be filtered (at k = 0), P is the number of smoothing points (the filter
width) and M = (P – 1) / 2. The boxcar filter does not introduce a time lag.

Like the other filters, the boxcar filter also attenuates the signal; the degree of attenuation is
directly proportional to the frequency of the signal and the number of smoothing points. The
following figure compares the attenuation of 10, 50 and 100 and 500 Hz sine waves (sampled at
10 kHz) at various filter lengths:

Boxcar Filter Attenuation vs. Number of Smoothing Points

That filtering periodic signals with the boxcar filter can introduce a periodic attenuation
response, as seen with the 500 Hz signal. This occurs because the filter output for the current
point is the mean of its value and the values of its immediate neighbors. The output therefore
depends on the relative proportion of high and low data values within a given filter length.
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Butterworth Lowpass Filter (8 pole) Specifications

10% to 90% step rise time: 0.46/fc

Maximum overshoot: 16.0 %

Attenuation: 160 dB at f = 10 fc

The Butterworth lowpass filter has a maximally flat response at low frequencies and a
monotonically decreasing amplitude response with increasing frequency. The group delay is
not constant so the Butterworth filter exhibits ringing and a substantial overshoot in response to
a step function. This filter, however, has sharper roll-off characteristics than the Bessel filter. It is,
therefore, better suited than the Bessel for frequency domain applications such as noise
analysis. However, because of its nonconstant group delay characteristics this filter should
generally not be used for time-domain analysis of biological data.

Expected vs. Observed Overshoot
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Expected vs. Observed Rise Times

Normalized Frequency Response
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Chebyshev Lowpass Filter (8 pole) Specifications

10% to 90% step rise time: 0.53/fc

Maximum overshoot: 16.0%

Attenuation: 193 dB at f = 10 fc

The Chebyshev lowpass filter has a maximally sharp transition from the passband to the
stopband. This sharp transition is accomplished at the expense of ripples that are introduced
into the response. The Chebyshev filter in Clampfit Batch Analysis has a fixed ripple of 1 dB. Like
the Butterworth, the sharp roll-off characteristics of the Chebyshev filter make it suitable for
analysis of data in the frequency domain, such as noise analysis. Although the Chebyshev filter
has a sharper roll-off than the Butterworth, it exhibits an even larger overshoot and more
ringing. Therefore, it is also not generally suitable for time-domain analysis of biological data.

Expected vs. Observed Overshoot
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Expected vs. Observed Rise Times

Normalized Frequency Response
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Gaussian Lowpass Filter Specifications

10% to 90% step rise time: 0.3396/fc

Maximum overshoot: 0%

Attenuation: 90 dB at f = 10 fc

The Gaussian FIR filter forms a weighted sum of the input values to form an output value
according to the following recurrence formula:

where aj are the Gaussian coefficients that sum to unity.

The Gaussian filter is particularly suited for filtering biological data for analysis in the time
domain as it produces no overshoot or ringing and introduces no phase delay. The
disadvantage is that it can be slow at high fc/fs ratios where the number of filter coefficients is
large.

Expected vs. Observed Rise Times

Normalized Frequency Response
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Notch Filter (2 pole) Specifications

The number of poles of the notch filter is fixed at two. This filter has essentially zero gain (–inf
dB) at its center frequency and about unity gain (0 dB) elsewhere. The notch filter has
approximately zero phase shift except at its center frequency, at which the phase shift is
undefined (because the gain is zero). In both respects (magnitude and phase) the resonator
behaves like a real analog tuned circuit.

The following figure shows the frequency response of the notch filter with a 60 Hz center
frequency with a 10 Hz –3 dB width.

Notch Filter Frequency Response (60 Hz center frequency, 10 Hz –3 dB width)

Settling Points

The –3 dB width has a significant influence on the number of points required for the notch filter
to settle, the narrower the notch the greater the number of settling points. For example, for a 60
Hz sine wave sampled at a frequency of 1 kHz, applying a 60 Hz notch filter with a 1 Hz –3 dB
width requires 2000 sampling points for the filter to reduce the amplitude to 0.1% of its original
value (–60 dB). In contrast, a 60 Hz notch filter with a 10 Hz –3 dB width requires only 200
points.

The number of settling points also increases with increasing sampling frequency. For example,
a notch filter with a –3 dB width of 10 Hz requires 2000 settling points for data sampled at 10
kHz compared to 200 for data sampled at 1 kHz.

The relationship between the number of settling points (Ps) and the sampling frequency (fs) and
–3 dB notch width (W–3dB) is given by:

for attenuation of the center frequency by 60 dB.
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RC Lowpass Filter (single pole) Specifications

10% to 90% step rise time: 0.3501/fc

Maximum overshoot: 0%

Attenuation: 20 dB at f = 10 fc

The RC filter function is equivalent to that of a simple first-order electrical filter made up of a
single resistor and a single capacitor. The RC filter introduces a phase delay to the output, but
the group delay is constant so that there is no ringing or overshoot. The recurrence formula for
this filter is:

where Y(n) is the current output, X(n) is the current data point, Y(n–1) is the output for the
previous point and:

where

where dt is the sampling interval and f is the –3 dB cutoff frequency.

Expected vs. Observed Rise Times

Normalized Frequency Response
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RC Lowpass Filter (8 pole) Specifications

10% to 90% step rise time: 0.34/fc

Maximum overshoot: 0%

Attenuation: 80 dB at f = 10 fc

The 8-pole RC filter is a ‘multiple coincident pole’ realization where the data points are filtered
by applying 8 single pole RC sections in succession. The recurrence formula for this filter is,
therefore, identical to that of the single pole RC filter except that the output from each previous
pole is used as the input for the successive pole, where:

for p = 1 to 8, where Y(n) is the output from the current pole, X(np) is the filter output of the
previous pole for the current point, Y(np–1) is the output from the previous pole for the previous
point and:

where

where fN is the normalized cutoff frequency. With the coincident pole design the cutoff
frequency rises as the order of the filter is increased. The normalized cutoff frequency, fN, is
given by:

where n is the order (number of poles) of the filter. For an 8-pole filter this value is 3.32397. The
specified cutoff frequency must be divided by the normalization factor in order to adjust the
positions of the multiple poles. A consequence of this is that the maximum fc/fs ratio must be
limited to the Nyquist frequency (fc/fs = 0.5) divided by the normalized cutoff frequency, or 0.5 /
3.32397 = 0.15.
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Expected vs. Observed Rise Times

Normalized Frequency Response
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RC Highpass Filter (single pole) Specifications

Attenuation: 20 dB at f = 0.1 fc

The single-pole RC highpass filter operates by subtracting the lowpass response from the data.
This is valid in this case because of the constant group delay characteristics of the single pole
RC filter. The recurrence formula for this filter is, therefore:

where Y(n) is the current output, X(n) is the current data point, Y(n–1) is the output for the
previous point and:

where

where dt is the sampling interval and f is the –3 dB cutoff frequency.

Normalized Frequency Response
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Bessel Highpass Filter (8-pole analog) Specifications

Attenuation: 114 dB at f = 0.1 fc

The highpass Bessel filter has a sharper roll-off than the highpass RC filter. However, the Bessel
filter deviates from ideal behavior in that it introduces ringing in the response to a step function,
as shown below.

Highpass Bessel Filter Step Response

Normalized Frequency Response



Clampfit Batch Analysis User Guide

70 5061586 E

Electrical Interference Filter

The electrical interference (EI) Filter removes power line interference from an acquired data
signal. This filter identifies and removes complex power line waveforms composed of multiple
harmonics. The interference detection method is adaptive. The filter always matches the actual
line signal even if its properties (frequency, phase, and shape) change during measurement.

The core component of the EI filter is the sine detector that discriminates sinusoids from other
additive signal components. The sine detector generates a reference sine wave and adjusts its
phase until it locks to a specific line-interference harmonic. The EI filter uses an array of sine
detectors, one for each harmonic of the interference waveform.

The sine detector basically operates as a digital Phase Locked Loop (PLL) tuned to line
frequency (50/60 Hz) or its multiple. The correlator (phase detector) detects phase difference
between the reference and actual line harmonic. This phase difference is used as a feedback
signal to adjust the reference phase until a perfect match is achieved.

Reference signals, each locked to a specific interference harmonic, are subtracted from the
original signal, thus canceling out the complete interference waveform.

Assumptions

1. The line interference and the data signal are statistically independent, for example,
uncorrelated.

2. The line signal x(n) is stationary across at least M of its periods. We can assume that the line
signal does not significantly change when observed at any M of its periods.

3. The measured signal s(n) is the sum of data signal y(n) with scaled and phase shifted
(delayed) version of the line signal: s(n) = y(n) + Ax(n–d).

Problem Statement

We want to identify line signal x(n) incorporated inside s(n). We assume that line signal is
composed of a certain number of sinusoids with harmonic frequencies. According to
assumption 3, we need to determine A and d for each harmonic.

Basic Theory

In order to detect the line signal we use the fact that data signal y(n) and line signal x(n) are
uncorrelated. Practically, we say that cross correlation Rxy is equal to zero:

for each d, where ∆ is the number of samples per period of the line signal. In order to keep the
argument as simple as possible, we will use the term ‘correlation’ Rxy meaning in most places
actually ‘covariance’, implicitly assuming all signals to have zero DC component. The correlation
of the line signal x(n) and the measured signal s(n) should equal to:

where Rxx is the autocorrelation of the line signal. Since Rxy is equal to zero, we conclude that if
we correlate the line signal and measured signal, we will obtain the autocorrelation of the line
signal. The autocorrelation function Rxx(d) is even and its maximum is at d = 0. Furthermore,
since x(n) is periodic, Rxx is also periodic with the same period.

We use the above argument to determine both the delay d and the scale A of the line signal
inside the measured signal (see assumption 3). The above discussion holds for our specific
situation if we assume that x(n) is a sinusoidal reference signal.
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Electrical Interference Filter Block Diagram

The adaptive line interference filter block diagram for the fundamental harmonic is shown in
Figure 5-1. The same procedure is repeated for each harmonic by multiplying the frequency of
the reference generator.

Figure 5-1: Adaptive line interference filter block diagram

Implementation

The low pass filter is implemented as the simple average over M line periods. The average of
the product of two signals, as in correlation definition, is equal to applying a low pass filter with
box impulse response, or sin(x)/x transfer function.

The critical parameter for correlator performance is the averaging period M. The higher the
value of M, the lower the bandwidth of the equivalent low pass filter. By keeping the bandwidth
as low as possible, we reduce the correlation estimate error. Since we ultimately need to
estimate the autocorrelation of the periodic signal x(n), the averaging period should be equal to
a whole number of line signal periods M.

The EI filter generates a reference sine wave for each detected harmonic up to the maximum
specified harmonic search number and subtracts reference waveforms from the signal, thereby
canceling line interference. Ideally, each reference sinusoid exactly matches the corresponding
interference harmonic both in phase and amplitude, resulting in the perfect cancellation of line
interference.
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A practical EI filter never exactly detects phase and amplitude of interference harmonics. After
subtraction of the generated reference sinusoids any discrepancy in amplitude and phase will
result in artifact sinusoids, that is, components that were not present in the original signal. After
filtering, artifactual components actually replace the original line harmonics. When harmonic
detection is good, the total power of artifact components after filtering is much lower than line
interference power in the original signal.

Harmonic detection errors come from noise and data signal components at line harmonic
frequencies (multiples of 50/60 Hz). Generally, noise errors are less significant and can be
successfully reduced by increasing the number of cycles to average. A more significant source
of EI-filter errors are original data signal components that fall at or close to 50/60 Hz multiples
(data signal leak).

Weak Harmonics

Weak line harmonics in the presence of noise cannot be accurately detected. In extreme cases
EI-filtering artifact power for the single weak harmonic can be larger than the actual harmonic
power. In such cases it might be better to reduce the harmonic search number in order to
exclude weak harmonics. Also, increasing the number of cycles to average will always improve
harmonic detection (if the noise is the main error source). However, excessively large number of
cycles to average will negatively affect execution speed, tracking performance and startup
transient compensation.

Data Signal Components

Periodic

Any periodic components in the data signal with frequencies at or very close to 50/60 Hz
multiples will leak through the EI filter harmonic detectors and will produce false line
interference harmonics.

Figure 5-2 shows the result of filtering a pure (no noise and no line interference) square wave at
10 Hz with the harmonic search number set to 3 and reference frequency set to auto.

Figure 5-2: Results of filtering a square wave

Since a 10 Hz square wave has strong components at multiples of 10 Hz, the EI filter locked on
to the 5th (50 Hz), 10th (100 Hz) and 15th (150 Hz) harmonics, generating prominent artifacts.
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Aperiodic

Strong and sharp pulses in the data signal may produce artifacts in the EI filtering process.
Sharp pulses (spikes) have significant components at all frequencies including 50/60 Hz
multiples. If the spike amplitude is two (or more) orders of magnitude larger than actual line
interference amplitude, the EI filter will produce false line harmonics after the spike in the region
whose size is equal to the number of cycles to average.

In the example below the EI filter was used at 10 harmonics with 50 cycles to average. Spike
amplitude (not shown in full) was more than 200 mV. Notice the false line harmonics in Figure 5-
3.

Figure 5-3: EI filtering showing introduction of false line harmonics

Start-up Transients

Start-up transients are spurious, rapidly changing false harmonics at the very beginning of the
filtered signal. When processing samples at the beginning of the signal file EI filter does not
have enough information to accurately detect line harmonics. With every new processed
sample the detection becomes better and better and the start-up transient becomes smaller
and smaller. The filter reaches its steady state after a time equal to number of cycles to average.

The EI filter automatically compensates for start-up transients by turning off reference
subtraction until it reaches its steady state. When it reaches steady state after the specified
number of cycles to average the EI filter assumes that line interference parameters are
accurately detected and filters the signal backwards using current reference parameters.
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Potential Problems

The Filter is Too Slow

When dealing with large datasets and high sampling rates the filter might be slow. If filtering is
unacceptably slow try the following:

Check if it is necessary to remove all harmonics specified in the harmonics field. Try
removing only the first harmonic, and if the result is not satisfactory, increase the harmonic
number and try again. The removal of the first three harmonics will often sufficiently reduce
the interference.
Decrease the value in the Cycles to average field. Often, smaller averaging lengths (time
constants) do not significantly affect the output signal quality.

Interference is not Fully Removed

If the line interference is not fully removed try the following:

If residual interference contains high frequencies then it is might be necessary to increase
the value of the upper harmonic to be removed.
If the fundamental line harmonic is still visible in the output signal then the number of cycles
to average should be increased.

Cutoff Frequency Limitations

All digital filters have inherent limitations, and in some cases deviate significantly from their
analog counterparts. The filters in Clampfit Batch Analysis have been restricted to an fc/fs ratio
where the filter response is reasonably close to the theoretically expected response.

The theoretical frequency range of digital filters is between 0 and the Nyquist frequency,
which is one-half of the sampling frequency. This applies to all filters when filtering sampled
data. However, the usable range of most software filters is considerably narrower than this
theoretical range. The usable range depends on the nature of the filter (FIR or IIR) and the
filter algorithm.
The overshoot during a step response is a characteristic feature of Bessel, Butterworth and
Chebyshev lowpass filters. For analog filters, the magnitude of the overshoot is constant
over the full operating range. For digital IIR filters, however, the overshoot becomes
increasingly larger as the ratio of fc/fs increases.
The operating range of the Gaussian FIR filter is limited at the low end by a practical, rather
than theoretical, limitation. Low ratios fc/fs result in the generation of a large number of filter
coefficients. This creates two problems. The first is that smaller datasets cannot be
accurately filtered because the filter length might be greater than the number of data
points. The second is that the large number of coefficients is computationally inefficient.
The number of Gaussian coefficients is inversely proportional to the fc/fs ratio where a lower
cutoff frequency requires a greater number of coefficients for the filter realization.
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The following table lists the numerical limitations for each filter type. The lower and upper cutoff
frequencies are expressed as a factor times the sampling frequency (fs). These limits are
internally set by the filter algorithm and cannot be altered.

Filter Type Lower Cutoff Limit Upper Cutoff Limit

Bessel (8-pole IIR) 10-4 x fs 0.14 x fs

Boxcar (FIR) See note 1. n/a

Butterworth (8-pole IIR) 10-4 x fs 0.2 x fs

Chebyshev (8-pole IIR) 10-4 x fs 0.2 x fs

Electrical Interference See note 2. n/a

Gaussian (FIR) 10-4 x fs See note 3. 0.5 x fs

Notch (2-pole IIR) 10-3 x fs 0.3 x fs

RC (single-pole IIR) 10-4 x fs 0.5 x fs

RC (8-pole IIR) 10-4 x fs 0.15 x fs. See note 4.

Note: 1
The boxcar filter requires that the number of smoothing points be specified. This must be
an odd number in order for the filter to be symmetrical. The minimum number of
smoothing points is 3. The maximum number of smoothing points is 99. However, the
maximum number of smoothing points is also limited by the number of data points, n,
such that the filter width is at least n/2. So if there are 50 data points the maximum
number of smoothing points is 50 / 2 = 25. If this formula generates an even number then
the maximum number of smoothing points will be one less. For example, if there are 52
data points, then the maximum number of smoothing points will be 52 / 2 – 1 = 25.

Note: 2
The electrical interference filter does not have a lower or upper cutoff frequency limit as
it is preset to remove either 50 Hz or 60 Hz interference and the associated harmonics
(see Electrical Interference Filter on page 70). However, there is a data point minimum,
as this filter requires a specific number of points to reach steady state. This minimum is
given by:

minimum points = samples per period × cycles to average

where the samples per period is the sampling frequency divided by the reference
frequency (50 Hz or 60 Hz) and cycles to average is the number of cycles of the
reference frequency which are averaged in the response. For example, for a sampling
rate of 1 kHz, a reference frequency of 60 Hz and 20 cycles to average the minimum
number of data points required is 1000 / 60 x 20 = 334 data points.
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Note: 3
The Gaussian filter width (see Finite vs. Infinite Impulse Response Filters on page 53)
depends on the fc/fs ratio; the lower this ratio the greater the number of Gaussian
coefficients (see Gaussian Lowpass Filter Specifications on page 63). In view of this, two
criteria are used to limit the lower cutoff frequency.

The first is that there must be enough data points to accommodate at least two Gaussian
filter widths. That is, the minimum corner frequency will correspond to a filter width that is
less than or equal to one-half the number of available data points.

The second is that the maximum number of Gaussian coefficients is limited to
approximately 3500. This limit, which corresponds to an fc/fs ratio of about 3x10–4, is not
exact because the automatically computed minimum corner ratio is generally rounded
up. Therefore, the minimum corner ratio might correspond to a number of coefficients
that is somewhat more or less than the 3500 limit.

Note: 4
The 8-pole RC filter is a ‘multiple coincident pole’ design where the –3 dB cutoff
frequency rises with each pole by an amount given by:

where fN is the normalized cutoff frequency and n is the number of poles. Therefore, for
an 8-coincident-pole filter the normalized cutoff frequency is actually 3.32397 times the
specified cutoff frequency (see RC Lowpass Filter (8 pole) Specifications on page 66).
Consequently, the maximum fc/fs ratio must be limited to the Nyquist frequency (fc/fs =
0.5) divided by the normalized cutoff frequency, or 0.5 / 3.32397 = 0.15.
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Chapter 6: Curve Fitting

Clampfit Batch Analysis offers a powerful and flexible tool for fitting curves to data. An extensive
set of options should satisfy the most demanding requirements. Four different search methods
support a large number of predefined functions as well as user-defined (custom) functions.
Automatic seeding of function ‘parameters’ is provided for the predefined functions. Graphically
assisted seeding is also available for more demanding fits that require accurate determination
of initial seed values.

A ‘fitting method’ is composed of a search method, a minimization method and an optional
weighting method. The search method is the algorithm that reduces the difference between the
data and the fitted function. The minimization method is used to specify the quantity that is to be
minimized (or maximized in the case of maximum likelihood). The search methods include
Levenberg-Marquardt, variable metric, Simplex and Chebyshev.

The minimization methods include sum of squared errors, maximum likelihood, mean absolute
and minimax.

The weighting methods include function weighting, data weighting, bin width weighting or no
weighting.

Linear and polynomial regression routines are also provided. These noniterative methods are
automatically used when linear regression or polynomial regression is selected from the
predefined function list. However, custom-defined linear or polynomial functions can only be
fitted by means of one of the iterative search methods.

Fitting Model

A fitting model, or simply, model is defined as any function that is fitted to the data. Functions
with different numbers of terms are considered to be different models. For example, a two-term
exponential function and a three-term exponential function represent different models.

Function Parameters

The term parameters refers to those coefficients of the fitting function that are adjusted during
fitting. For example, in the following function, A, τ and C are the function parameters. In all
predefined functions the variable C is a constant offset in the y direction:

Parameters are or are not adjusted by the fitting routine depending on whether they are free or
fixed. Fixed parameters, which are essentially constants, are always assigned a standard error
of zero.

6
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Parameter Errors

All search methods report a standard error for each parameter in the fitting function. Parameter
errors are estimated by evaluation of a covariance matrix using Gauss-Jordan elimination. The
method of error evaluation is identical for all fitting methods, so the results of fitting by different
methods can be compared directly.

Some parameter errors cannot be estimated because the covariance matrix cannot be
evaluated. In this event the message Could not compute parameter errors. displays.

The parameter errors provide an estimate of the uncertainty in the determination of the
parameters. They do not provide information about the goodness of the fit. The correlation
coefficient and the standard deviation of the fit are more reliable indicators of the quality of the
fit. If the fit is poor the parameter errors are likely to be meaningless. The parameter errors are
an indication of how reliably the parameters of a model were determined for a dataset, where
small errors suggest that the parameter estimates are reliable regardless of the quality of the fit.
The parameter errors can be small although the deviation between the fitted curve and the
data might be large.

For small datasets the parameter error estimates can be quite large (perhaps even larger than
the parameter estimates themselves), but the fit can still be good. Statistical parameters such as
estimated errors cannot be as reliable with small datasets as with larger sets.

Fitting Failure

The fitting algorithms Analysis are robust and perform satisfactorily in most cases. There is the
possibility that a fit will fail.
The most likely reasons for a fit failure are:

The data are very poorly described by the fitting function.
The initial seed values were very inaccurate.
Sign restrictions were applied and the search algorithm cannot assign acceptable positive
values to the function parameters, for example, the data cannot be reasonably well
described by the sign‐restricted fitting function.

In the event of a fit failure possible solutions are:

Ensure that the data are indeed reasonably well‐represented by the fitting function. If not,
select or define a different fitting function. Also, try a different number of terms or run a
model comparison.
Assign more accurate seeds to the fitting function. Graphical seeding should be helpful.
Use the variable metric search method. This search method is the most reliable for forcing
function parameters positive.
Disable the Force parameters positive option.
Reduce the tolerance. This could result in a poorer, although still acceptable, fit.
Reduce the maximum number of iterations. Sometimes an acceptable fit can be achieved
(as judged by the parameter errors and the quality of the fitted curve) even though the fit
does not converge. This is especially true for Simplex, which can continue to search for
many iterations even though it is very close to the function minimum.

In the event of a failed fit the error displays in the Results window. When fitting multiple sweeps,
errors do not cause execution to stop. If an error occurs while fitting a sweep, the error displays
in the Results window and fitting continues with the next sweep. If you have fitted a series of
sweeps you should check the fitting results to ensure that all sweeps are successfully fitted.
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Numerical Limitations

The maximum number of data points that can be fitted is 110,000.
The maximum number of function terms (where applicable) is 6.
The maximum power (where applicable) is 6.
The maximum number of parameters in a custom function is 24.
The maximum number of independent variables in a custom function is 6.
Only one dependent variable is allowed in a custom function.
The maximum number of points for functions that contain a factorial term is 170.

Units

The fitting routines in Clampfit Batch Analysis do not make any assumptions about the units of
the data. The variety of data sources and the potential for various data transformations makes
the automatic tracking or assignment of units virtually impossible. Consequently, units are not
displayed along with the reported parameter values. It is up to the user to determine the units of
a particular function parameter.

Levenberg-Marquardt Method

The Levenberg-Marquardt method supports the least squares, mean absolute and minimax
minimization methods. The explanation given here is for least squares minimization but the
general principle is the same for all minimization functions.

The sum of squared errors (SSE) is first evaluated from initial estimates (seed values) for the
function parameters. A new set of parameters is then determined by computing a change
vector ∆P that is added to the old parameter values and the function is reevaluated. The value
of ∆P will depend on the local curvature in the ‘parameter space’ that can be evaluated to
determine the optimal rate and direction of descent toward the function minimum. This process
continues until the SSE is ‘minimized’ at which time the fit is said to have converged. The criteria
by which is judged to be at its minimum are different for the different search methods.

The Levenberg-Marquardt search method combines the properties of the steepest descent and
the Gauss-Newton methods. This is accomplished by adding a constant λ to the diagonal
elements of the Hessian matrix that is associated with the gradient on the parameter space. If λ
is large the search algorithm approaches the method of steepest descent. When λ is small the
algorithm approaches the Gauss- Newton direction.

The method of steepest descent can optimally find major changes in the data and thus works
best in the early stages of the fit when the residual of the sum of squares is changing
substantially with each iteration. The Gauss-Newton method is best for smoothing out the fit in
later stages when these residuals are no longer changing substantially (see Schreiner et al.
1985). The Levenberg-Marquardt method requires that the first derivative of the function f(x,P)
be evaluated with respect to each parameter for each data point. These derivatives are used to
evaluate the ‘curvature’ in the local parameter space in order to move in the direction of the
perceived minimum. For predefined functions the exact derivative is calculated. For custom
functions a numerical derivative (central difference) is computed using a step size of 10–7.

As the fit progresses some steps may result in a poorer (larger) value of the SSE. However, the
general trend is a reduction in the SSE.
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The Levenberg-Marquardt method does not report SSE during the fitting process but rather
reports the standard deviation (σ). However, s follows the same trend as the SSE, that is, if the
SSE increases then σ also increases, and vice-versa. In fact, the standard deviation is reported
by all search methods, providing a standard criterion for judging the fitting quality regardless of
the search method. The standard deviation is given by:

where n is the number of data points, Obs is the observed value and Exp is the expected value
as calculated using the fitting function.

Levenberg-Marquardt Convergence

Convergence is reached when the parameter change vectors go to zero, which occurs when a
minimum is reached in the local parameter space. Because of this the fitting function might
converge to a minimum that is not necessarily the lowest (global) minimum in the entire
parameter response surface. Convergence to a local minimum often results in a poorly fitted
curve and so is easily recognized. If you suspect that the fit has converged on a local minimum,
you should specify new fitting seed values (graphically-assisted seeding is very useful here) and
retry the fit. Alternatively, use a different fitting method. For example, the Simplex search
method is not as prone to convergence at a local minimum.

The iterations are also stopped (convergence is assumed) when the change in the minimization
function (for example, the SSE) is less than a preset value. This value can be set in the Precision
field on the Function/Method tab in the fitting dialog. The default value is 10–6.

Normally, it is preferable to allow the parameters to converge naturally. Convergence on a
precision criterion can result in a poorer fit especially if the precision criterion is reached before
the individual parameters have converged. On the other hand, some ‘difficult’ fits might require
hundreds or even thousands of iterations if only the change vector criterion is used for
convergence. In order to favor convergence on the basis of change vectors but to also allow
difficult fits to converge on the basis of an acceptable ‘precision’ value, the fitting routine
converges on the precision criterion only if this criterion has been met over at least 100
successive iterations. Given this criterion it is not likely that further improvements in the
minimization function will lead to a better fit, so the iterations will stop.

Levenberg-Marquardt Precision

The default Levenberg-Marquardt precision is 10–6.

The Levenberg-Marquardt precision sets the minimum absolute change in the minimization
function (for example, the SSE) that signifies convergence. This minimum difference must be
satisfied over at least 100 successive iterations. That is, if:

absolute(SSE(old) – SSE(new)) < Precision

over 100 consecutive iterations, convergence is assumed. A less stringent precision value could
facilitate convergence for a particularly difficult dataset, but often at the expense of fitting
accuracy. In any case, the statistics of the fit should always be carefully evaluated in order to
determine whether or not the fit is acceptable.
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Simplex Method

The Simplex method supports the least squares, mean absolute, maximum likelihood and
minimax minimization methods. The explanation given here is for least squares minimization but
the general principal is the same for all minimization functions.

The Simplex search method is based on the algorithm of Nedler and Mead (1965), and is an
example of a direct search approach that relies only on the values of the function parameters. It
does not consider either the rate or the direction by which the function is approaching the
minimum on the parameter response surface. However, the direction in which the function
parameters proceed is not purely random but rather relies on a clever strategy that takes
advantage of the geometry of the response surface.

A simplex is a geometric figure that has one more dimension than the parameter space in which
it is defined. The vertexes of the simplex are first separated by adding an ‘offset’ to the initial
seed values. The function to be minimized is then evaluated at each vertex to identify the
lowest and highest response values. For example, a simplex on a two-dimensional space
(corresponding to a two-parameter function) is a triangle that may have the following
appearance:

Figure 6-1: A simplex for a two-parameter function

where P1 and P2 are the parameters, Vhigh is the vertex which has the highest (worst) function
value, Vlow is the vertex which has the lowest (best) function value and Vmid represents an
intermediate function value. A ‘downhill’ direction is established by drawing a line from Vhigh

through a point midway between Vmid and Vlow. The algorithm then tries to find a point along
this line that results in an SSE which is lower than the existing vertexes.

The simplex changes shape by reflection, contraction, expansion or shrinkage. The first point
tested is the reflected point Vref which lies a distance of 2d along the line from Vhigh. This
reflected simplex is accepted if its response is neither worse than Vhigh nor better than Vlow. If
the response is better than Vlow then the algorithm performs an expansion by moving a distance
of 4d along the line from Vhigh. The expansion is accepted if it has a lower (better) response than
the previous best. Otherwise the reflection is accepted.

If the reflection results in a higher (worse) response than Vhigh then the algorithm tests a
contraction by moving a distance of 0.5d toward the midpoint on the line. If this produces a
better response then the simplex is accepted; otherwise shrinkage occurs where all vertexes
except Vlow move toward the midpoint by one-half of their original distance from it.
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The advantage of the Simplex algorithm is that it is considerably less sensitive to the initial seed
values than the gradient search algorithms. It will rapidly approach a minimum on the parameter
response surface usually in the space of several tens of iterations for a multicomponent
function.

The disadvantage of the Simplex fitting method is that its sensitivity does not increase when it is
in the vicinity of a minimum on the parameter space.

Another problem can arise in that the Simplex algorithm may find what it perceives to be a local
minimum but the fractional error is still greater than the convergence criterion (see below). In
this case iterations may continue endlessly. To circumvent this problem, the fitting routine will
stop when there is no change in the fractional error for 30 iterations. Even if the above error
criterion is not met, the fit is assumed to have converged. This occurrence is reported as a
Stable Fractional Error in the Results Window. The displayed value of σ might be the same for
many more than 30 iterations before the fitting routine is terminated. This is because σ is
reported as a single precision value whereas the fractional error is a double precision value.

The weighting options are not available with Simplex fitting. This is because weighting
interferes with the ‘travel’ of the simplex and greatly reduces the chances of convergence.

Simplex Convergence

The Simplex algorithm can converge in one of three ways. The iterations are stopped when the
fractional error is less than or equal to a preestablished ‘precision’ value.

The simplex is moved over the parameter space until the ratio of the response of the best and
worst vertexes reaches a preset minimum fractional error, at which point the function is said to
have converged:

The quantities on the right-hand side of the equation are based on one of four minimization
methods that Simplex can use, namely least squares, maximum likelihood, mean absolute or
minimax.

The fractional error is computed for the simplex for each dimension (each having a Vhigh and
Vlow simplex). All simplexes must have a fractional error less than the value of precision for
convergence.

Simplex Precision

The default Simplex precision is 10–5.

The Simplex search is deemed to have converged when the fractional error is less than or equal
to the Precision value. The fractional error can be based on one of four minimization methods,
namely least squares, maximum likelihood, mean absolute or minimax.
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Variable Metric Method

The variable metric method supports the least squares and maximum likelihood minimization
methods only.

Variable metric algorithms are designed to find either the minimum or the maximum of a multi-
dimensional non-linear function f. The minimum is used in chi-squared or least squares
applications and the maximum in maximum likelihood estimation.

Clampfit Batch Analysis uses minimization of least squares, which is asymptotically equivalent
to likelihood maximization for most applications. The parameter values that determine the
global minimum of f are optimal estimates of these parameters. The goal of the variable metric
algorithm is to find these estimates rapidly and robustly by an iterative method.

Clampfit Batch Analysis uses the variable metric algorithm introduced by Powell (1978) and
implemented by Dr. Kenneth Lange (UCLA). At each iteration the algorithm computes the exact
partial derivative of f with respect to each parameter. The values of these derivatives are used
in building an approximation of the Hessian matrix, which is the second partial derivative matrix
of f. The inverse of the Hessian matrix is then used in determining the parameter values for the
subsequent iteration. Variable metric algorithms have several desirable characteristics when
compared with other methods of non-linear minimization. Like the simplex algorithm, variable
metric algorithms are quite robust, meaning that they are adept at finding the global minimum of
f even when using poor initial guesses for the parameters. Unlike simplex, however,
convergence is very rapid near the global minimum.

Variable Metric Convergence

The variable metric search method converges when the square of the residuals, or the
maximum likelihood estimate if using likelihood maximization (see Maximum Likelihood
Comparison on page 99), does not change by more than a preset value over at least four
iterations. This value can be set in the Precision field in the Function/Method tab of the fitting
dialog. The default value is 10–4.

Variable Metric Precision

The default variable metric precision is 10–4.

The variable metric search is assumed to have converged when the square of the residuals, or
the maximum likelihood estimate if using likelihood maximization, does not change by more
than the Precision value over at least four iterations.
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Chebyshev Transform

The Chebyshev technique is an extremely rapid, stable, noniterative fitting technique with a
goodness of fit comparable to that of iterative techniques. It was developed by George C.
Malachowski and licensed to Axon Instruments. The explanation in this section only describes
how the Chebyshev transform is used to fit sums of exponentials.

The Chebyshev Transform transforms a dataset to the Chebyshev domain (in this case, domain
refers to a functional basis, in which datasets are considered in terms of scaled sums of
functions), using a method equivalent to transforming data to the frequency domain using
Fourier transforms. Instead of representing the data using a sum of sines and cosines, the
Chebyshev transform uses a sum of the discrete set of Chebyshev polynomials (described
below).

Transforming the data allows it to be fitted with various functions of biological interest: sum of
exponentials, Boltzmann distribution and the power expression (an exponential plus a constant
raised to a power). For each of these functions, it is possible to derive an exact, linear,
mathematical relationship between the fit parameters and the coefficients of the transformed
data. If the dataset has noise present, as is almost always the case, these relationships provide
estimates of the fit parameters. However, as the relationships are linear, high-speed regression
techniques can be applied to find the parameters.

This method has the following properties: extremely fast fitting at a rate that is independent of
noise, comparable goodness of fit to that of iterative techniques, and it always finds a fit.

At present this technique has one limitation: it can only be used on datasets that have equally
spaced data points. This makes it inappropriate at present for fitting histogram data with
variable bin widths.

Orthogonal Polynomial Set

An Nth order polynomial is a function of the form:

where a0, a1, a2, ... aN are the coefficients of the polynomial, and aN cannot be zero unless N is
zero.

A set of polynomials consists of one polynomial from each order (P0(x), P1(x), P2(x), P3(x), ...), in
which adjacent members of the set are related by a generating equation. Mathematicians
usually represent a polynomial set with a single letter. In the case of the Chebyshev
polynomials, the letter is ‘T’ (from previous anglicization of Chebyshev as Tchebysheff). A
polynomial set is said to be orthogonal if every member in the set is orthogonal to every other
member. In the case of the Chebyshev polynomials, T0 is orthogonal to T1, T2, T3, T4, and so on,
T1 is orthogonal to T2, T3, T4, T5, and so on.

Orthogonal means at a right angle; synonyms are perpendicular and normal. Those familiar with
vectors may recall that two vectors are tested for orthogonality using the dot product; two
vectors are said to be orthogonal if their dot product equals zero. Similarly, two functions that
are defined only at discrete points in time are said to be orthogonal if the sum of their product
over all sampled points is zero. (This relation may only be true on a restricted range (for
example, x Є [–1, 1]), and with a weighting function present.)
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Transform Data to the Chebyshev Domain

All orthogonal function sets have the property of being able to represent a function in terms of a
sum (or integral) of the members of the set. Depending on the function being represented, an
appropriate scaling factor is chosen for each member of the set. A function f(t) can be
represented as a sum over the Chebyshev polynomials by the relation:

where Tj (t) is the jth member of the Chebyshev polynomial set and dj is its scaling factor. In
general, a sum of an infinite number of Chebyshev polynomials is required to represent a
continuous function. In the case of a sampled dataset with N sampled points, a sum of only N
Chebyshev polynomials, from order 0 to N-1, is required to exactly represent the dataset. In this
case, t is not continuous, but is rather a set of data points tj, where j runs from 0 to N-1. The
above equation then becomes:

, for (1)

This sum of polynomials exactly equals the function at all points in time, even though the
individual members may only cross the function at a few points.

A function that has been represented this way is said to have been transformed to the
Chebyshev domain, and the scaling factors (the djs) are usually referred to as the coefficients of
the transform. Do not confuse these transform coefficients with the individual coefficients that
make up each of the member Chebyshev polynomials! The member polynomials’ coefficients
never change; the coefficients of the transform change with f(tj).

Calculate the Coefficients

The orthogonality property of the Chebyshev polynomials makes calculating the djs
straightforward. Recall that every member Tk is orthogonal to every other member Tj, for all k ≠j.
To determine each coefficient (dk), both sides of the above equation are multiplied by Tk, then
summed over all values of ti:

where Tk is the member whose coefficient is to be determined. Rearranging, and summing over
all data points ti eliminates all Tjs except Tk, leaving (after several steps):

The summation on the right-hand side is usually written as a normalization factor (Rk). Solving for
dk:

(2)
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Discrete Chebyshev Polynomials

The generating equation for the Chebyshev polynomials is given by (Abramowitz and Stegun,
page 792):

where Tj(t) is the Chebyshev polynomial being generated, and N is the number of data points. It
is clear that each Tj(t) depends on the previous two members in the set: Tj-1 (t) and Tj-2 (t). The
zeroth member of this set is defined to be: T0 = 1, from which all higher-order members may be
derived. T1 and T2 are shown below:

Clearly, T0 is a horizontal line, T1 is a sloping line and T2 is a parabola.

Isolate the Offset

The offset of a dataset can be isolated from the data in the Chebyshev domain. Consider the
general case of a function containing an offset; we can rewrite this function in terms of its
nonconstant and its constant parts:

where g(ti) is the nonconstant part of the function. Using this function in Equation 2 we derive:

The above equation is simply the sum of the Chebyshev transforms of g and K. This can be seen
if we write the transform coefficients of g as d'j(g), and the transform coefficients of K as d''j(K):

However, T0 = 1 implies that the Chebyshev transform of K is nonzero only for the zeroth

coefficient (d''0(K)). (K can be rewritten as KT0, and T0 is orthogonal to all other Chebyshev
polynomials.) We therefore have:

    for   

Once a dataset has been transformed to the Chebyshev domain, we can isolate the effect of
the constant offset by not using d0 in our calculations of the other parameters.
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Transform an Exponential Dataset to the Chebyshev Domain

Suppose we wish to transform an exponentially decaying signal f (ti) to the Chebyshev domain,
where f (ti) is defined as:

To exactly represent f (ti) requires N coefficients, where N is the number of data points in the set.
However, we can approximate f quite well with a sum of just a few polynomials. A pure,
noiseless exponential with time constant 25 ms, sampled every 1 ms from t = 0 to t = 255 ms,
when transformed to the Chebyshev domain has the following first 11 coefficients:

The magnitudes of the coefficients rise to a peak at d2, then decline slowly as the coefficient
index increases. Using these coefficients to approximate the exponentials by forming a sum of
the first 11 Chebyshev polynomials approximates the original exponential to at worst 4.5 x 10–5.
Below is a graph of the exponential data, with the above Chebyshev fit superimposed upon it.
Inset in this graph is a greatly magnified view of the residuals between the fit and the
exponential. The polynomial-like oscillation of the residuals about the data.

Figure 6-2: Graph of exponential data with Chebyshev fit superimposed.

Although 11 Chebyshev coefficients are sufficient to well approximate an exponential dataset,
the presence of high frequency noise would require many more coefficients to accurately
represent the data. If fewer coefficients are used, the approximation will appear filtered.
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Integrate an Exponential Function in the Chebyshev Domain

Let us say that we have a function f (t) that we wish to integrate, and that its integral is F(t). In the
discrete domain, where we only have a finite set of data points (usually evenly spaced), we write
the discrete integral as:

The discrete integral F (t) is defined at each value t by the sum of the previous values from 0 to
t–1. Using t–1 as the end point of the integration serves to ensure that the forward difference
equation is equal to f (t):

A difference equation in the discrete domain is analogous to a differential equation in the
continuous domain. The equation shown above in the continuous domain would be expressed
as dF/dt = f (t). Forward difference refers to using t and t+1 to form the difference.

How are the Chebyshev transforms of the integral F and f related? If we were to transform f to
the Chebyshev domain, we would obtain a set of coefficients dj (f ). Similarly, if we were to
transform F, we would obtain a different set of coefficients dj (F). Comparing these two sets of
coefficients, dj (f ) and dj (F) we would find the relation:

(3)

where Dj (F) is the jth coefficient of F(t) and N is the number of points in the data. This equation
cannot tell us the value of D0(F), as there is no d–1 (f ) coefficient.

(This formula is derived in A Method that Linearizes the Fitting of Exponentials, G. C.
Malachowski). This equation is critical to the use of this technique. Proof of this relation is long;
those interested may refer to the appendix of the above paper. Briefly though, it can be
described as follows: integrating the Chebyshev transform of a function is the same as the sum
of the integrals of each of the Chebyshev polynomials making up the transformation. The
integral of a polynomial is itself a polynomial. It turns out that after much simplification and
rearrangement, each coefficient in the transform of the integral is a sum of the two adjacent
coefficients in the transform of the original function.) If f is an exponential function, the following,
very similar, relationship exists:

(4)

where k is defined as:

or, solving for τ :

(5)



Chapter 6: Curve Fitting

5061586 E 89

Basically, these equations tell us that any adjacent triplet of Chebyshev coefficients forms an
exact relationship that tells us the value of tau. Notice how Equation 4 further restricts the value
of j to be greater than one: it is only true for those coefficients that do not contain the constant
offset term.

Thus, integrating an exponential function in the Chebyshev domain allowed us to determine the
value of tau. This is similar to the case of integrating an exponential function in the continuous
domain:

For reasons that will become clear in the section on the fitting of two exponentials, the right-
hand side of Equation 4 can be written as d1j (f), which stands for the Chebyshev coefficients of
the first integral of f. Equation 4 then becomes:

(6)

where k is as defined in Equation 5.

Calculate Tau

Now we can calculate τ using Equations 4 and 5. Choose any triplet of Chebyshev coefficients,
and use those values in Equation 4 to get the value of k. Then use k in Equation 5 to calculate τ .
Every triplet has the same, redundant information built into it: triplet d1, d2, d3, triplet d2, d3, d4,
and so on. The following is an example of the values of τ predicted using the 8 triplets of the
first eleven Chebyshev coefficients.

Note: Remember that d0 cannot be used as it contains information about the offset of the
exponential, if present.

The small differences between the calculated value and the actual value (25) are due to the
limited precision of the coefficients used. In general, double precision numbers are used to
calculate the fit parameters (τ , the amplitude and the offset).
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Calculate the Amplitude

To determine the amplitude of the exponential, we must change directions completely, and
generate an exponential dataset based on the value of tau just calculated. The generated
dataset will have unity amplitude and zero offset:

Transforming this generated set to the Chebyshev domain will give us a different set of
coefficients (d'j (g)). Now we can determine the value of the amplitude of our dataset by
comparing the dj(f)’s from our dataset to those of the generated set d'j (g)’s. Recalling that the
function that we are trying to fit is:

we can transform this function to the Chebyshev domain as:

The Chebyshev coefficients for g(ti) are very similar to those for f(ti):

Comparing these two equations yields the following relationship between the Chebyshev
coefficients of f and those of g:

The amplitude is contained redundantly in all of the coefficients of the two transforms,
excluding the zeroth coefficient. This redundancy is similar to that seen in the calculation of tau.

Calculate the Offset

Calculating the offset is similar to calculating the amplitude: we compare the zeroth index
coefficients from the two sets of transforms:

Unlike τ and a1, the offset information is not redundantly stored in the transform coefficients.

Calculate the Fit Parameters in the Presence of Noise

If the dataset being fit contains noise, Equations 4, 5, 7 and 8 are no longer exactly true. For
example, when calculating t, each triplet gives an estimate of τ .
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Estimating τ
Recall that for j > 1, Equation 4 shows a relationship between k and each triplet of Chebyshev
coefficients. In the case of noise, this relationship is not strictly true; di (f)/k is an estimate of the
right side of this equation. Equation 6 then becomes:

The value of k that minimizes the following expression will be k':

where the sum generally does not include all N of the coefficients, but generally includes only
those coefficients with a significant contribution to the transform; usually n is chosen to be 20.
Expanding the squared term, differentiating with respect to k, setting the derivative to 0 and
rearranging gives us our estimate of k:

Once k has been estimated, Equation 5 will give the corresponding best estimate of τ .

Estimating a1

A similar technique is used to calculate the best estimate of the amplitude a1. The ratios of the
coefficients of our dataset (dj (f)’s) to the coefficients of the pure exponential (d'j(g)’s) now give
estimates of the amplitude:

This can be rewritten as:

As in the case of estimating tau, we form a linear regression equation to find the best estimate
of a1 (a1'):

Expanding the squared term, differentiating with respect to a1, setting the derivative to 0 and
rearranging gives us:

Estimating a0

The estimate of a0 is calculated by substituting the above value of a'1 into Equation 8.



Clampfit Batch Analysis User Guide

92 5061586 E

Fit the Sum of Two Exponentials

In the two exponential case, two taus must be found. To do so, we shall integrate the function to
be fit twice, and solve the resulting set of simultaneous equations for τ 1 and τ2. (This procedure
is somewhat complicated.) Once we have the two taus, solving for the amplitudes and the offset
is a simple extension of the procedure for fitting a single exponential.

Let gτ 1 (ti) represent a unity‐amplitude exponential with time constant τ 1 and let gτ2 (ti) represent
a unity‐amplitude exponential with time constant τ2. Then we can write:

Transforming both sides of this equation gives us:

or

where and are the Chebyshev

coefficients of a0, gτ 1 and gτ2, respectively. To isolate the constant term from the calculations
that follow, we shall only use coefficients wherej > 0, yielding:

since the offset is only contained in the zeroth coefficients.
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Use the Coefficients of f and its Integrals to Determine the Taus

What if we were to integrate both sides of Equation 12? (since we are dealing with discrete data
points, we use a summation). From Equations 4, 5 and 6, we know the coefficients of the
integral of an exponential function, and we know how those coefficients are related to the
coefficients of the exponential function itself. Applying those relationships to this sum of two
exponentials case yields:

or using Equation 6 to rewrite in terms of the coefficients of gτ 1and gτ2 themselves:

where

Integrating both sides of Equation 13 again:

where we write the Chebyshev coefficients of the second integral of f as d2j(f). j now must be
greater than two. (The exact reason for this is beyond the scope of this description (see
Malachowski’s paper) however, briefly, it is required to isolate the effect of the offset from the
calculation of the taus.) Substituting in Equation 6 again gives us our final relation that we need
to determine τ 1 and τ2:

Solve a Set of Simultaneous Equations to Determine k1 and k2

Equations 12, 14 and 16 now form the three relations that we need in order to determine the
taus. Rewriting them below we have three equations in three unknowns dj, d1j and d2j, and
restricting j to be the same in all cases:

In order for these three equations to be simultaneously true, there must exist a pair of
parameters x1 and x2 such that for all j > 2:

The solution to this equation is a straight line in x1–x2 coordinate space. To solve it, we add up
the three simultaneous equations, and gather the like terms to find:
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The values of x1 and x2 that satisfy this equation are:

as can be seen by substituting these values into the above equation.

Our strategy will be to solve for x1 and x2, from them calculate the values of k1 and k2, and finally
use Equations 15a and b to calculate the corresponding values of τ 1 and τ2. To do so, we must
first solve for k1 and k2 in terms of x1 and x2 (Equations 18a and b are the converse). There is no
direct, algebraic method to do so, but we can recognize that Equations 18a and b are the roots
of the quadratic polynomial:

as can be seen by factoring the polynomial into the product of its roots:

This means that we can determine k1 and k2 by using x1 and x2 to form the above quadratic
polynomial, and then solving for its roots. For a quadratic polynomial, we use the quadratic
formula. For higher‐order polynomials, such as are used for fitting higher order exponentials, an
iterative, root‐finding method is used.

What if there are not two, real roots? Recall that the quadratic formula either yields two real
roots, one real root, or two complex roots. This corresponds geometrically to two crossings of
the X‐axis, one tangential ‘touch’ of the axis, or no crossings of the axis.

If there is one real root, then the data being fit only consisted of a single exponential. In this
case, this technique would yield two taus with the same value as that of the single exponential,
and with amplitudes each one‐half of the amplitude of the single exponential.

If there are two complex roots, the data being fit is not a pure exponential. Rather, it is the
product of an exponential and a harmonic function (for example, a cosine). This function is
commonly called a ringing response, or an exponentially‐damped cosine. This can be seen by
substituting a complex number into Equations 15a and b (a ± bi),

rewriting the resulting number in terms of a complex exponential ( reiθ),

where r is and θ is tan -1(b/(a+1)) , taking the logarithm, substituting back into
Equation 11, and simplifying.

substituting back into Equation 11, and simplifying.
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Finding the Taus in the Presence of Noise

In the presence of noise, f (tj) is not an exact sum of exponentials, and therefore the Chebyshev
coefficients dj, d1j and d2i do not lie along a straight line, but are scattered:

To find the best line through the data, we form the following regression equation, and minimize
the χ2 value:

The best values for x1 and x2 are determined by expanding this relation, minimizing it first with
respect to x1, then with respect to x2. After rearranging we have the following set of
simultaneous equations:

Direct solution of simultaneous equations is a well‐known problem in mathematics; an iterative
matrix technique is used here. This allows us to easily solve for the more difficult case of finding
the solution to a set of m simultaneous equations, which must be used when fitting the sum of m
exponentials.

Find the Amplitudes of the Two Exponentials

Once the taus of the sum of exponentials are known, a technique similar to the single‐
exponential, noise present, case is used to find the amplitudes and the offset. (The
corresponding two‐exponential case without noise is not shown.) We generate two exponential
datasets based on the values of τ 1 and τ2 just calculated; both datasets have unity amplitude
and zero offset:

Recalling from Equation 12 that the transform of f is the scaled transform of gτ 1 and gτ2, the
resulting coefficients of each of these datasets is scaled and added together. In the presence of
noise, however, this relationship is not

exactly true. Rather:

Linear regression of this equation yields the best possible values of a1 and a2 that satisfy:

Solution of this equation is not shown, but involves expanding the square inside the summation,
minimizing first with respect to a1 and then to a2, and solving the resulting simultaneous set of
equations for a1 and a2.

Find the Offset

Finally, to find the offset, a formula similar to Equation 8 is used; no regression need be done:
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Fit the Sum of Three or More Exponentials

Fitting the sum of three or more exponentials is a simple extension of the fitting the sum of two
exponentials case. A full description is not given here.

Speed of Fit

In tests the Chebyshev technique fit speed was completely unaffected by noise. There was a
slight dependence on the number of exponentials being fit.

In contrast to these results, with iterative techniques, fitting a sum of two exponentials usually
requires twice as much time, fitting a sum of three exponentials requires three times as much
time, and so on.

Goodness of Fit

In tests comparing the Chebyshev method to the Simplex iterative search method, both yielded
the same values of the fit parameters in low‐noise and no‐noise conditions. The tests added
varying amounts of noise to exponentials generated from known values. As the noise levels
increased, these two methods produced slightly different values of the fit parameters for each
test case, although the average of the parameters was the same. At extremely high levels of
noise (the peak‐to‐peak noise reached 30% of the peak of the exponential), the Chebyshev
search clearly did not fit as well as the Simplex method, in those times that the iterative Simplex
converged at all.

Like all fitting methods, the Chebyshev method fits sums of exponentials data best if the dataset
spans several times the largest time constant in the exponential. Although the Chebyshev
method consistently outperforms other iterative techniques in this regard, even it can generate
incorrect fits in this situation (for example, trying to fit an exponential function with a time
constant of 2000 ms to a dataset spanning just 10 ms!). In particular, as the amount of noise
increases, its ability to fit an insufficiently sampled dataset decreases.

The Chebyshev method performs most poorly when fitting data with extremely low‐frequency
signals present. This may occur under the following circumstances: 60 Hz noise present (or
other low‐frequency noise) or insufficiently averaged data (as may occur by forming a
macroscopic current from an insufficient number of single‐channel records: for example, the
single channel events may still be seen). This occurs since low‐frequency noise will appear
most strongly in the low‐index Chebyshev coefficients, the same coefficients that contain most
of the information of the exponential. Although iterative techniques do not perform well in this
case either, when they converge they do so to the correct result more often than the
Chebyshev technique.

Success of Fitting

The Chebyshev technique very rarely fails to find a fit to the data when fitting exponentials or
sums of exponentials, as it uses mathematical relationships and linear regression techniques.
Experimentally though, it sometimes fails to find a good fit (see above conditions) and can even
fail altogether with some kinds of data (for example, if the x and y data values are identical). In
particular, since the Chebyshev technique always finds an answer so quickly, it is tempting to
assume that this answer is always correct. Be sure to always compare the fitted data to the
dataset.

Note: The Chebyshev method can fail when fitting shifted Boltzmann or exponential
power functions, although the failure in these cases is expected to be very rare. In the
event of a failure, all function parameters will reported as zero.
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Fit Sums of Exponentials to Non-Evenly Spaced Datasets

At present, the Chebyshev method only works with datasets having equally spaced points,
since the relations derived here depend upon that assumption. With datasets that were
sampled at two different rates (split‐clock acquisition), you must first use the Analyze >
Interpolation command to fill in the missing data points using linear interpolation.

Note: At the time of this writing the Chebyshev search method had not been published in
a peer‐reviewed journal. While Molecular Devices has conducted many empirical tests
that have confirmed the accuracy of the fits, you should occasionally compare
Chebyshev‐fitted results to those of one or more of the other fitting methods.

Maximum Likelihood Estimation

Data are fitted by maximizing the logarithm of the likelihood with respect to a set of fitting
parameters. Exponentially distributed data (ti) are described by one or more components (k) of
the form:

where t1, t2 . . . tn are the n measured data points and τ j is the time constant of the jth component.
Each aj is a fraction of the total number of events represented by the jth component where:

The likelihood (L) of obtaining a given set of observed data ti, given the form of the distribution
and the set of function parameters (denoted here by θ) is the product of the probabilities of
making each of the N observations:

As the likelihood typically takes on very small values the numerical evaluation of its logarithm is
preferable. In practice, limited frequency resolution of the recording system makes it impossible
to record events shorter than tmin. To generalize this case it is also assumed that no events
longer than tmax can be measured. Taking these corrections into consideration, the conditional
PDF is given by:

where:

is the probability that the experimentally measurable dwell‐times fall within the range delimited
by tmin and tmax given the probability distribution with parameters θ. In Clampfit Batch Analysis
tmin and tmax are defined by the lower and upper limits of the data’s time base.
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The fitting algorithm used here is not, strictly speaking, a maximum likelihood estimation. It is an
iteratively reweighted least squares fit to the number of elements in a bin (which should
converge on the maximum likelihood estimates of the parameters in this case). The weighting
here has to do with the expected variance of the number of elements in a bin, which is Poisson
distributed. So the weighting factor is the inverse of the variance (remember that mean =
variance in a Poisson distribution). The iterative aspect has to do with the fact that the number
of elements per bin gets moved around to correct for censoring (i.e., short events are not
measurable). Because of the simple form of the ‘weighted’ sum of exponentials (that’s a
different weight), the derivatives of the minimized function with respect to each parameter can
be written directly and corrected for this Poisson‐distributed variance.

Maximum Likelihood for Binned Data

The log likelihood Lb of observing a particular set of bin occupancies ni for a given set of dwell‐
time data of times ti is calculated by:

where F(ti) and F(ti+1) are the probability distributions at the lower and upper bounds of the ith bin
using the parameter values θ, and p(ts,tk) is the probability that the experimental dwell‐times fall
within the range (k) of the histogram where

In Clampfit Batch Analysis, the probability distribution function (equation 1), rather than the
probability density function (equation 2), is used in the calculations. F(t) is evaluated at each bin
edge. The difference gives the probability that an event falls in the bin. This is equivalent to
integrating the PDF over the width of the bin.

For a sum of m exponential components the probability distribution function is given by:

where θ is the entire set of coefficients comprising the fraction of the total number of events in
each ith component ai and the time constants τ i. The coefficients ai sum to unity, where:

Therefore, the set of parameters θ has 2m–1 degrees of freedom. Clampfit Batch Analysis can
use either the Simplex or variable metric search methods to find the set of parameters that
maximize Lb(θ). Only the variable metric method constrains the coefficients ai to sum to unity. In
the Simplex method, these parameters are not constrained and the set of parameters has 2m
degrees of freedom.

Maximum likelihood will operate on either logarithmically binned or conventionally binned
histograms. It is, however, recommended that logarithmically binned data be used if MLE is the
fitting method. With conventional binning, it is often not possible to select a bin width that can
represent the data satisfactorily if the time constants are widely spaced. This problem can be
avoided by binning the data into the variable‐width bins of a logarithmic histogram.

EM Algorithm

The EM (Expectation step – Maximization step) algorithm computes maximum likelihood
parameter estimates for binned observations from a mixture of exponentials. This algorithm is
used in Clampfit Batch Analysis to estimate initial seed values for maximum likelihood estimates
for fitting exponential probability functions.
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Model Comparison

When you increase the order of the fitting function for non-linear fitting routines, the fitted curve
appears to improve (until it becomes difficult to distinguish between successive order fits). You
can usually choose one fit over another by visual inspection, but visual inspection is not a
substitute for a statistical comparison, especially if two different models produce fits that are
visually similar. Clampfit Batch Analysis allows you to statistically compare different models that
are fitted with either a least‐squares routine or with maximum likelihood.

When you select model comparison, the text compare models displays next to the function
name above the equation window. If the function does not support model comparison, the
model comparison status text is blank.

Maximum Likelihood Comparison

When you compare two models, F and G, which are fitted using the maximum likelihood
method, the probability densities for these models are given by f (x, θ) and g (x, β) where x is the
dataset, and β and θ are the function parameters with dimensions kf and kg (where kg > kf). The
natural logarithm of the likelihood ratio (LLR) for F and G is defined as:

where β and θ are the parameter values that maximize the likelihood for each probability
density. The suprema of f (x,θ) and g (x,β) are denoted by supθ (x,θ) and supβ (x,β), respectively.
When model F is true, 2LLR has a Chi‐square distribution with kg – kf degrees of freedom.

For example at a confidence level of 0.95 (p < 0.05) for kg – kf = 2 degrees of freedom Chi‐
square is 5.991. If 2LLR < 5.991 then it is assumed that model G does not represent a significant
improvement over model F and model F is selected as the best fit.

Least Squares Comparison

In the case of least squares fitting (Simplex or Levenberg‐Marquardt fitting methods) the SSE for
models F and G is defined as:

and:

where xi are the n data points, f (xi |θ) and g (xi |) are the values predicted by models F and G,
respectively, and θ and β are the set of function parameters that minimize SSE.

To compare models F and G a form of the likelihood ratio test is used. In the case of least
squares fitting the statistic T is defined by:

where SSEf and SSEg are the sums of squared errors for models F and G, respectively. T has an
F‐distribution which can be compared with a standard F‐distribution table, with kf and n–kg
degrees of freedom. This statistic is denoted in Clampfit Batch Analysis by ‘F’.

Note: The degrees of freedom (kf and n–kg) is different for each successive model.



Clampfit Batch Analysis User Guide

100 5061586 E

Define a Custom Function

The rules to define a custom function and associated issues are as follows:

Only one dependent variable is allowed. The dependent variable is already expressed, as
is the equal sign, so these should not be entered as part of the equation. Only the right‐
hand side of the equation should be specified.
When fitting from Analysis window data, only one independent variable is allowed. This
variable must be expressed as x1 (or X1).
When fitting from a Results window, up to six independent variables are allowed. These
variables must be expressed as x1...x6 (or X1...X6).
The maximum number of function parameters is 24. Parameter names must be expressed
as p1...p24 (or P1...P24).
The maximum length of the function including parenthesis is 256 characters.
Parameter labels (p), independent variable labels (x) and mathematical operations such as
log, sin, etc. are not case-sensitive.

Automatic seeding is not available for custom functions. You must specify all seed values
before the fit will start. If you try to start fitting before you specify all parameter seeds, an error
message displays.

Graphically assisted seeding is not available when fitting to data from a Results window. If you
require graphical seeding for fitting Results window data, save the data to a .atf file, then import
the .atf data into an Analysis window for graphical seeding and fitting. The data can contain only
positive, uniformly spaced independent variable values (X‐axis data) for proper display in the
Analysis window. Only a single independent variable can be specified for fitting from the
Analysis window.

The custom function is compiled when you switch from the Function/Methods tab to either of
the other tabs in the fitting dialog. Once compiled, the equation displays on the line above the
equation window in the fitting dialog. If there is an error in the expression, compiler warnings
display.

Be careful with parentheses. For example, be aware that 2*x1+p2 is not the same as 2*(x1+p2). In
the former case 2*x1 is evaluated before p2 is added to the product, whereas in the latter case,
x1+p2 is evaluated before the multiplication is performed.

Multiple-Term Fitting Models

A fitting model can be expressed as a sum of identical functions (terms). Each term in a multiple‐
term model will be assigned a ‘weight’ or ‘amplitude’ that will reflect the contribution of that
term to the fitted curve. For example, a two‐term standard exponential will be of the form

where A1 and τ 1 are the amplitude and time constant, respectively, for the first term and A2 and
τ2 are the amplitude and time constant, respectively, for the second term. The variable C is a
constant offset term along the Y‐axis.
Multiple terms for custom functions must be explicitly defined within the custom function itself,
for example, the above two‐term exponential function would be specified as

where p1 and p3 are the amplitudes, p2 and p4 are the time constants and p5 is the constant
offset term.
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Minimization Functions

Sum of Squared Errors

Levenberg‐Marquardt, variable metric and Simplex only. The function to be minimized is

where SSE (sum of squared errors) is the sum of the squares of the difference between the data
yi and the fitting function y = f (x,P) with a set of parameters P to be fitted over N data points. The
optimal values for P are assumed to occur when SSE is at a minimum. Weighting may or may not
be applied to modify this function.

Maximum Likelihood Minimization

Variable metric and Simplex only.

Maximum likelihood estimation (MLE) is available only for the standard and log‐transformed
probability exponential functions and only with the variable metric or Simplex search methods.
Moreover, these functions are intended to be used with binned data. That is, the dependent
variable values (X‐axis data) are assumed to be bin center values. Strictly speaking, the
likelihood is maximized so the use of ‘minimization method’ might be deemed inappropriate
here. However, the fitting method minimizes the negative of the log likelihood value, which is
equivalent to maximizing the positive log likelihood.

See Maximum Likelihood Estimation on page 97 for a description of the algorithm.

Mean Absolute Minimization

Levenberg‐Marquardt and Simplex only.

Mean absolute minimization is a linear criterion that weights a badly-fitted data point
proportionately to its distance from the fitted curve, rather than the square of that distance. If
some points have substantially more error than others then the best sum of squares fit might
deviate from the more reliable points in an attempt to fit the more reliable ones. The mean
absolute error fit is influenced more by the majority behavior than by remote individual points. If
the data are contaminated by brief, large perturbations, mean absolute error minimization might
perform better than sum of squares minimization.

The function E to be minimized is

Minimax Minimization

Levenberg‐Marquardt and Simplex only.

Minimax minimization yields a fit in which the absolute value of the worst‐fitted data point
residual is minimized. This might be useful for certain datasets when the fit must match the data
within a certain tolerance. The function E to be minimized is

where max (yi – y) is the largest absolute difference between the data and the fit.
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Weighting

For the search methods that support least squares minimization (Levenberg‐Marquardt, variable
metric and Simplex)) the sum of the squares (SSE) of the difference between the data (fiobs) and
fitted curve (fi(θ)) is minimized, where

This works quite well when uncertainties are random and not related to the time or number of
counts. However, the uncertainty observed is often a function of the measured value y, such
that for larger values of y there are substantially greater deviations from the fit than for smaller
values of y. To compensate for this, weighting becomes quite useful during the assessment of
the fit, where:

None

In this case the denominator f (θ) is 1.

Function

Weighting the sum of squared errors function generates the Chi‐square (Chi2) function. The Chi2

value for a function with a given set of parameters θ is given by:

where m is the number of points in the histogram fitting range, fi (θ) is the fit function calculated
for the ith data point, and fiobs is the observed value of the ith point.

Data

This is a modified form of the Chi2 function, where:

where m is the number of points in the histogram fitting range, fi(θ) is the fit function calculated
for the ith data point, and fiobs is the observed value of the ith point.

Bin Width

Weighting by the bin width weights the sum of squared errors by the width of each ith histogram
bin, such that:

where xi is the right bin edge value and xs is the left bin edge value. Bin width weighting is
allowed only for the predefined log‐transformed exponential function that assumes log‐binned
data. It is not available for custom functions.

The selected weighting type will also be applied to mean absolute and minimax minimization.

Note: To apply different weighting criteria, you can export the data to a results sheet,
modify the data using column arithmetic and subsequently fit the data directly from the
results sheet.
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Normalized Proportions

The normalized proportion is the absolute value of that parameter divided by the sum total of
the absolute values of all of the proportion terms, that is:

Normalized proportions are most likely to be specified with the exponential probability
functions or the Exponential, weighted/constrained function. The variable metric method (and
only this method) constrains the proportion terms to sum to 1.0 during fitting (see Variable
Metric Method on page 83), but only for the standard or log‐transformed exponential probability
functions when using maximum likelihood or the weighted/constrained exponential with least
squares.

Zero-shifting

In cases where the natural origin for a dataset is ambiguous or inappropriate, it would be
desirable to shift the origin of the data that are to be fitted to zero. For example, if a time
constant of an exponential curve is to be extracted from an arbitrary segment of a large dataset
it would be reasonable to force the selected fitting range to start at zero. In the same vein, it
might also be desirable to set a zero origin just after a stimulus artifact. To this end, the ‘zero‐
shift’ option is provided. If zeroshift is enabled then for a set of i data points xi, each point x is
offset such that

x = xi – x0 where x0 is the value of the first data point.

However, it is important to note that zero‐shifting can affect the values of some fitted
parameters. Consequently, in some instances, zero‐shifting the data might not be appropriate
and could lead to unexpected results. For example, when fitting a ‘Z‐delta Boltzmann’ to
current/voltage data the parameter Vmid (the voltage at which the current is half‐maximal) will
differ depending on whether or not zero‐shift is enabled. In the following example, the data
were zero‐shifted prior to fitting.

Figure 6-3 shows a fit of the Z‐delta Boltzmann function to current/voltage data. The fitted curve
is the line without symbols.

Figure 6-3: Fit of Z‐delta Boltzmann function to current/voltage data.

In this fit Vmid is reported as +81.16 but from the data one would expect Vmid to be about –40 mV.
Nevertheless, the value of +81.16 is in fact correct because the first point (originally at –120 mV)
has been forced to zero such that the actual fitting range is from 0 to +140 mV. On this scale, the
reported positive value is a reasonable estimate of Vmid.
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If zero‐shift is disabled, the fitted curve looks exactly the same but Vmid is now reported as –
38.84 mV. The other parameters of this function are identical in both cases. As the expected
value for this dataset is indeed in the range of –40 mV, it is clear that in this particular case it
would not be appropriate to use zero‐shifting. In fact, if zero‐shift is inadvertently enabled it
would appear that the fitting routine is malfunctioning, which is not the case. It is, therefore, very
important that the status of the zeroshift option be known at all times when fitting.
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Chapter 7: Fitting Functions

Clampfit Batch Analysis provides a large selection of predefined fitting functions to assist in
data analysis. Some functions require that restrictions, such as forced positive parameters, are
applied during the fit. Accordingly, some options in the Curve Fit dialog might be automatically
set to comply with mandatory fitting requirements. Furthermore, some functions require
automatic preprocessing of the data, such as normalization, prior to fitting. In the function
descriptions below, any automatic data preprocessing and forced option requirements for a
function are listed on the line above the function formula.

The references cited provide sources for more detailed explanation of the functions and
examples of specific experimental applications.

Beta Functions

Requires a normalized X‐axis.
All parameters except the offset (C) are forced positive.

The beta function is used to describe the steady state filtered amplitude distribution of a two‐
state process, where α and β are rate constants and τ is the time constant of a first‐order filter.
This method has been used to measure block and unblock rates in the microsecond time range
even under conditions when individual blocking events were not time‐resolved by the
recording system.

This function describes a probability distribution that requires the X‐axis data range to be 0 to 1.
If the data do not meet this criterion the X‐axis values are automatically normalized prior to
fitting. These values are rescaled after fitting so that the fitted curve will conform to the original
data.

The beta function is intended to be used primarily with data that have been imported into a
Results or Graph window, and therefore has limited utility with respect to time‐based Analysis
window data.

The fit solves for parameters a, b, B(a,b) and the constant y‐offset C. The rate constants α and β
can be obtained by dividing a and b, respectively, by the filter time constant, τ . Clampfit Batch
Analysis does not perform this calculation.

The recommended fitting method is Levenberg‐Marquardt.

7
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Binomial

Requires an integral X‐axis.
Requires normalized data.

Maximum number of points = 170.

The parameter P is forced positive.

The binomial distribution describes the probability, P, of an event occurring in n independent
trials. For example, this function can be used to determine the probability for a particular
number of n independent ion channels being open simultaneously in a patch (Colquhoun, et al.
1995). This function has also been applied to quantal analysis of transmitter release.

This function requires integer values of x. If the X‐axis values are not integers then they are
converted to such prior to, and rescaled following, fitting. The ordinate data are also normalized
so that they range from 0 to 1, and are rescaled after fitting so that the fitted curve conforms to
the original data. Rescaling is such that the area under the fitted curve is equal to the area under
the original data curve.

The number of sample points for this function is limited to 170 to conform to the computational
limit for a factorial.

The binomial function has limited utility with respect to time‐based Analysis window data. It is
intended to be used primarily with data that have been imported into a Results or Graph
window.

The fit solves for the probability variable, P. Since the X‐axis scale is integral the fitted curve will
appear as a histogram.

The recommended fitting method is Levenberg‐Marquardt.
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Boltzmann, Charge‐Voltage

This function can be used to examine activation and inactivation profiles of voltage‐gated
currents.

The charge‐voltage Boltzmann distribution is given by

where Qon‐max is the maximum charge displaced, Emid is the potential at which Qon = 0.5 ´
Qon‐max, K is the number of millivolts required to change Qon e‐fold, and E is the measured
potential. C is a constant offset term. This function can be used to fit current‐voltage curves of
the form:

or

where V is the membrane potential, Vmid is the membrane potential at which the current is half‐
maximal, and Vc is the voltage required to change I or g e‐fold. If I or g are normalized then the
data points should be input as I/Imax or g/gmax and the dependent variable Imax or gmax in the
function above should be fixed to 1.0.

The fit solves for Imax (or Gmax), Vmid, Vc and the constant y‐offset C.
The recommended fitting method is Levenberg‐Marquardt. The variable metric method also
works well with this function but is slower to converge.

Boltzmann, Shifted

Like the standard Boltzmann, this function also defines a sigmoidal curve. A is the amplitude, τ
is the ‘slope’ and C is a constant offset in the y direction (see Boltzmann, standard). However,
unlike the standard Boltzmann function, the shifted Boltzmann includes an offset parameter B
that shifts the curve along the X‐axis such that the half‐maximal amplitude is at x = -ln(1/ B) ∙τ .
Thus, this function is to be used when fitting a sigmoidal curve to data where the half‐amplitude
point is expected to be displaced from zero along the X‐axis.
The fit solves for A, B, and the constant y‐offset C for each component i.

The recommended fitting method is Levenberg‐Marquardt or Chebyshev if fitting only a single
term.
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Boltzmann, Standard

This function defines a sigmoidal curve. Unlike the shifted Boltzmann function, this function
does not include an offset parameter along the X-axis.

The physical correlates for A and x are not specified in this equation. It is up to the user to
define these quantities. For example, A might be conductance and x might be cell membrane
voltage. The parameter τ is the slope of the function that specifies the change in x required to
produce an e‐fold change in A. A is half‐maximal at x = 0 (where f(x)=A/1+e-0/τ)=A/2).
Consequently, the fitted curve is sigmoidal only if there are both positive and negative x data
with the half amplitude at or very close to zero. If the half‐amplitude is offset significantly from
zero the shifted Boltzmann function should be used.

The fit solves for the amplitude A, the width τ and the constant y‐offset C for each component i.

The recommended fitting method is Levenberg‐Marquardt.

Boltzmann, Z‐Delta

This function can be used to analyze the voltage dependence of gating charges in ion channels
(Hille, 1992).

Vmin and Vmax are the minimum and maximum voltages, Zd is the magnitude of the charge
valence associated with the electric field V, Vmid is the voltage at which f (V) is half‐maximal, F
is the Faraday constant, R is the Gas constant, T is absolute temperature. The temperature is
optionally specified (in °C).

The fit solves for Vmax, Vmin, Vmid and the constant y‐offset C.
The recommended fitting method is Levenberg‐Marquardt.

Current‐Time Course (Hodgkin‐Huxley)

This is the Hodgkin‐Huxley model for describing the time course of voltage‐dependent ionic
membrane currents. This equation was originally used to describe voltage‐activated sodium
and potassium currents (with a = 3 and b = 1). The term k∞is the steady-state inactivation, I’ is the
maximum current that is achieved in the absence of inactivation, τ j is the activation time
constant, τ k is the inactivation time constant, and the power terms a and b are empirically
determined.

The fit solves for I’, τ j, τ k, k∞and the constant y‐offset C The power terms a and b must be
optionally specified.

The recommended fitting method is Levenberg‐Marquardt.
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Exponential, Alpha

The alpha exponential function has been used to describe temporal responses at the neuronal
soma to synaptic input.

The fit solves for the amplitude A, the time constant τ and the constant y‐offset C for each
component i.

The recommended fitting method is Levenberg‐Marquardt.

Exponential, Cumulative Probability

This function fits data that have been binned cumulatively. That is, each successive bin contains
its own data plus the data in all of the preceding bins.

This function should not be used for binned data because cumulative binning creates artificial
correlations between successive bins. The correlation occurs because each successive bin
contains all of the data in the preceding bins. The cumulative exponential function provides
meaningful results only if the data values are not correlated.

The fit solves for the proportion (amplitude) P, the time constant τ and the constant y‐offset C
for each component i.

The recommended fitting method is Levenberg‐Marquardt.

Exponential, Log Probability

Can only be used with Results or Graph window data.

The dwell‐time data (t) must be input as log10(t).

This function describes dwell‐time data, usually from single channel experiments, that have
been binned on a logarithmic time scale. Logarithmic binning is often preferable to conventional
linear binning because of its superior resolution of widely spaced time constants.

The fit solves for the proportion (amplitude) P, the time constant τ and the constant y‐offset C
for each component i.

The recommended fitting method is variable metric with maximum likelihood estimation.

Exponential, Power

The fit solves for the amplitude A, the time constant τ and the constant y‐offset C for each
component i. The power term a must be optionally specified.

The recommended fitting method is Levenberg‐Marquardt or Chebyshev if fitting only a single
term (Chebyshev can solve for a single term only).
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Exponential, Product

This function can be used to fit postsynaptic events (excitatory or inhibitory postsynaptic
potentials). The fit solves for the amplitude A, the rise time constant τ r and the decay time
constant τd for each component i.

The recommended fitting method is Levenberg‐Marquardt.

Exponential, Sloping Baseline

This function is used to fit an exponential of the standard form to data that are superimposed on
a sloping baseline, for example resulting from a constant baseline drift.

The fit solves for the amplitude A, the time constant τ for each component i, and the common
parameters, the slope m and constant y‐offset C for each component i.

The recommended fitting method is Chebyshev.

Exponential, Standard

This is the most basic function used to fit changes in current or voltage that are controlled by
one or more first‐order processes. The fit solves for the amplitude A, the time constant τ , and
the constant y‐offset C for each component i.

The recommended fitting method is Chebyshev.

Exponential, Weighted

This function is identical to the constrained exponential function except that the sum of the fi
components is not constrained to 1.

The fit solves for the proportion (amplitude) f, the rate constant K, the ‘weight’ K0 and the
constant y‐offset C for each component i.

The recommended fitting method is Levenberg‐Marquardt.

Exponential, Weighted/Constrained

Requires the variable metric fitting method.

This function has been used to describe the recovery rate of ground‐state absorption following
photo‐excitation of intercalated metal complexes bound to DNA.

The fit solves for the proportion (amplitude) f, the rate constant K, the weight K0 and the
constant y‐offset C for each component i. The fi terms sum to 1.0.

The fitting method must be variable metric.
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Gaussian

This is for data that can be described by one or more normal distributions. For n components,
the fit solves for the amplitude A, the Gaussian mean µ, the Gaussian standard deviation σ and
the constant y-offset C for each component i.

This function is generally used for describing amplitude distributions of single channel events
(Heinemann, 1995).

The recommended fitting method is Levenberg‐Marquardt.

Goldman‐Hodgkin‐Katz

This function can only be used with Results window data.

This function is used to describe the steady‐state dependence of membrane voltage on ion
concentrations and the relative permeability of those ions through the membrane.

The equation assumes that all the ions are monovalent. For positive ions [X]1 refers to the
concentration outside the membrane and [X]2 refers to the intracellular concentration. For
negative ions [X]2 refers to the concentration outside the membrane and [X]1 refers to the
intracellular concentration.

The fit solves for the permeability ratios α and β.
The recommended fitting method is Levenberg‐Marquardt.

Hill (4‐Parameter Logistic)

This is a modified form of the Hill equation that is useful for fitting doseresponse curves. The
half‐maximal concentration is determined directly. Imin refers to the baseline response, Imax

refers to the maximum response obtainable with drug x, C50 is the concentration at half‐
maximal response (inhibitory or excitatory) and h is the Hill slope.

The fit solves for Imin, Imax, C50 and h.

The recommended fitting method is Simplex.
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Hill, Langmuir

The Langmuir‐Hill equation allows for fitting a sum of Langmuir components. It is useful for
fitting data where non‐specific binding of the agonist is linear. Imax refers to the maximum
response obtainable with drug x, C50 is the concentration at half‐maximal response (inhibitory
or excitatory) and h is the Hill slope. C is a constant y‐offset.
The fit solves for Imax, C50, h and C.

The recommended fitting method is Simplex.

Hill, Steady State

This is a general equation that can be applied to many kinds of concentration‐dependent
pharmacological or ion channel responses. Vmax refers to the maximum response obtainable
with drug S. By definition a partial agonist will have a Vmax value that is less than the Vmax of a full
agonist. K is indicative of potency but it is not equal to the concentration at half‐maximal velocity
except when n = 1. The value of n places some limitations on the degree of cooperativity of the
liganddependent processes. In order to define a concentration-dependent inhibitory process, n
can be seeded with a negative value.

The fit solves for Vmax, K and n.

The recommended fitting method is Simplex.

Lineweaver‐Burk

This equation, derived by taking the reciprocal of both sides of the Michaelis‐Menten equation,
describes a straight line with a slope of Km/Vmax and a y‐intercept of 1/Vmax. It is useful for
gaining information on enzyme inhibition.

The fit solves for Km and Vmax.

The recommended fitting method is Levenberg‐Marquardt.

Logistic Growth

This function describes an exponential growth that is subject to saturation that occurs at the
limiting value Rmax. The parameter A is the number of times the initial value must grow to reach
Rmax, and B determines the rate and direction of growth. The function will increase when B is
positive and decrease when B is negative.

The fit solves for Rmax and A, B and the constant y‐offset C.
The recommended fitting method is Levenberg‐Marquardt.
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Lorentzian Distribution

The Lorentzian distribution function is generally used to characterize energy transition spectra
that exhibit homogenous broadening of the peak. For example, the natural line shape in
spectroscopy can be characterized by this function. The peak of a spectral line is narrow but
broadens as a result of uncertainties in the energy level of the excited state. It, nevertheless,
retains the Lorentzian line shape.

The fit solves for the area A under the curve, the half‐width ω of the peak, the X‐axis center µ of
the peak (generally the center frequency) and the constant y‐offset C for each component i.

The recommended fitting method is Levenberg‐Marquardt.

Lorentzian Power 1

The power spectra of current fluctuations can be described by the sum of one or more
Lorentzian functions of this form.

The time constant is related to the cutoff frequency, fc, at which the power has declined to S(0) /
2 by

The fit solves for S(0) and fc for each component i.

The recommended fitting method is Levenberg‐Marquardt.

Lorentzian Power 2

The power spectra of current fluctuations produced by ion channels can be described by the
sum of one or more Lorentzian functions of this form where:

If the probability of the channel being open is low relative to the probability of the channel being
closed then the channel closed time constant τ c can be ignored and τ can be equated to the
channel open time constant τo. At low frequencies the function tends toward S(0). At high
frequencies the spectrum decays in proportion to f 2.

The fit solves for S(0), τ and the constant y‐offset C for each component i.

The parameter τ has units of s if the frequency, f, is in Hz.

The recommended fitting method is Levenberg‐Marquardt.
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Michaelis‐Menten

This is a general equation to describe enzyme kinetics where [S] refers to the concentration of
substrate. In this equation, Vmax refers to rate of catalysis when the concentration of substrate is
saturating. Km refers to the Michaelis constant ((k‐1 + k2)/k1) where k1 and k‐1 are forward and
backward binding rates of the enzyme‐substrate complex, respectively, and k2 is the first‐order
rate constant for the formation of product from the bound enzyme‐substrate complex.

The fit solves for Vmax, Km the constant y‐offset C.

Nernst

This function describes the condition where an equilibrium exists between the energy
associated with membrane voltage (V) and the energy associated with a concentration gradient
of an ion species x. Hence, the Nernst potential for a given ion is often also referred to as the
equilibrium potential for that ion.

The fit solves for the concentration [x]2 given a series of concentrations [x]1.

Parabola, Standard

This is the parabolic function.

The fit solves for the parameters A, B and the constant y‐offset C.

Parabola, Variance‐Mean

This is a form of the parabolic function used to describe synaptic event data where i is the
unitary synaptic current amplitude and N is the number of release sites.

The fit solves for the parameters i, and N.
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Poisson

Requires an integral X‐axis.
Requires normalized data.

Maximum number of points = 170.

The data will be automatically zero‐shifted.
The Poisson distribution describes the probability of getting x successes with an expected, or
average number of successes denoted by λ. This is similar to the binomial function but is limited
to cases where the number of observations is relatively small.

This function requires integer values of x. If the X‐axis values are not integers then they are
converted to such prior to, and rescaled following, fitting. The ordinate data are also normalized
so that they range from 0 to 1, and are rescaled after fitting so that the fitted curve conforms to
the original data. Rescaling is such that the area under the fitted curve is equal to the area under
the original data curve.

The number of sample points for this function is limited to 170 to conform to the computational
limit for a factorial.

The fit solves for the λ given a series of observed probability values x. Since the X‐axis scale is
integral the fitted curve will appear as a histogram.

The recommended fitting method is Levenberg‐Marquardt.

Polynomial

The fit solves for the polynomial coefficients ai. The term a0 always exists in the solution. A first‐
order (or ‘one term’) polynomial is, therefore, given by

, which is a straight‐line fit.

The maximum order is 6.

Straight Line, Origin at Zero

This function is used to fit variance‐mean data (V‐M analysis) to estimate the unitary current, i.
The fit solves for the slope i, forcing the origin to zero.

Straight Line, Standard

The straight‐line fit solves for the slope m and the y‐intercept b.
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Voltage‐Dependent Relaxation

This function describes the relaxation kinetics for a two‐state voltagedependent process. The
forward and reverse rate constants are α and β, respectively. The term a0 is value of α at V = 0
and b0 is value of β at V = 0.

The fit solves for α, β, a0, b0 and the constant y‐offset C.
The recommended fitting method is Levenberg‐Marquardt.

Constants

F = Faraday constant = 9.648456 x 104 C/mol.

R = gas (Rydberg) constant = 8.31441 J/mol‐deg K.
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